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Introduction to EMS 
 

Welcome to EMS (Event Management Systems) District, a software for scheduling 

community use of school district facilities.  EMS encompasses the request for a room at 

your facility by community groups, clubs, sports teams and individuals all the way to the 

billing and receipt of payment.  The purpose of this manual is to answer questions and 

guide you through the EMS application.  Help may also be obtained directly within the 

EMS software by clicking on the Help option in the toolbar.   

1. Features:  Some key features of EMS District include: 

a. Finding availability and making reservations, even for regularly occurring 
activities. 

b. A visual tool for checking availability and scheduling rooms with a simple click 
and drag. 

c. A comprehensive billing and accounts receivable functionality 

d. Tracks extensive detail on the groups and individuals using your facilities, 
including contact information as well as copies of the Hold harmless Agreement 
and Certificate of Insurance.   

e. Provides scheduling of services like custodial needs and the selection of 
resources like A/V equipment pertinent to each scheduled event.  

f. Community groups, clubs, sports teams, and individuals can make room 
requests or view/cancel their bookings using Virtual EMS, an interface optimized 
for mobile devices. 

2. Responsibilities:   

a. Outside Organizations:  It is the responsibility of the outside organization 
(groups not generated by the existence of the school or the district, including for-
profit users, community groups, governments, and non-profit users) to complete 
an indemnification and hold-harmless agreement and provide a current certificate 
of liability which clearly states the organization’s liability coverage, naming the 
School Board as an additional named insured and certificate holder to the 
Finance Department prior to requesting a room at any district facility.   

b. School-based Organizations:  Although a school-based organization (volunteer 
groups generated by the existence of the school, such as booster clubs, parent-
teacher organizations, or associations, which are providing a service to the 
school) is not required to provide an indemnification and hold-harmless 
agreement or proof of insurance, a VCS employee representing this group must 
contact Finance for security access.   
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3. Getting Started in EMS:  (First time using EMS) 

a. Initial Setup: 

i. EMS must be installed on your computer.  Contact the Finance Department. 

ii. After EMS has been installed on your desktop, the following shortcut icon 
will appear:   

 

iii. Double click on the icon.  For the initial setup, when prompted, enter the 
following for the server name:  MSSQLCLS1INS1\N1 and for the database, 
enter:  EMS.   

iv. After the initial setup, you will not be required to type in the server name or 
database.  It will use your network sign on automatically.   

b. After the initial setup: 

i. Double click on the icon to start the EMS application.  You can also select 
the application from your Start menu.  The application should automatically 
open since it uses the single login (uses your information from your network 
login).  If, however, you are prompted for a user id and password, use your 
network user id and password.   

ii. The EMS main window is the starting point.  From here, you can choose 
options from the Menu bar, Tool bar, or the Main menu.    

 

Menu Bar 
Tool bar 

Main Menu 
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Chapter 1 
Facility Usage Guidelines 

 
This procedure details the documentation and process required for the community use 
of the school’s facilities.  Refer also to 1001.41 and 1001.42, Florida Statutes and 
School Board Policy 705. 
 

1. The School Board believes that the school district facilities should be made 
available for community purposes, provided that such use does not detract from 
the original and necessary purpose of the property or interfere with the 
educational program of the schools.   

2. The Superintendent or designee may authorize the use of school district facilities 
by outside organizations.  The participation by outside organizations in events 
that take place during school hours as part of a school’s educational operation 
shall not constitute the use of a school district facility.   

3. Schools use the EMS (Event Management Systems) software to manage the use 
of their facilities.  The software allows the school to schedule all rooms, prepare 
event calendars, send confirmations to renters and bill outside organizations for 
facility usage.   

4. Requests for facility usage shall be presented to the principal to recommend 
approval or denial.  The principal shall ensure compliance with procedures 
developed by the Superintendent.   

5. Any existing agreements between the School Board, a booster or volunteer 
group, or governmental agency shall govern facility usage as stated in the 
agreement and can only be terminated as provided within the agreement.  The 
use of a school district facility by the County of Volusia as an emergency shelter 
shall not require a fee.  

6. Facility usage agreements shall not go beyond one fiscal year (July 1 – June 30) 
unless approved by the school board or where the agreement is pursuant to an 
interlocal agreement approved by the school board.  

7. Sharing room space is not recommended, however it may be approved if no 
other space is available or if it is in the best interest of student safety.  Renters 
are responsible for up to the full rental rate of the room.   

8. Organizations and individuals using school district facilities must take proper and 
ordinary care of the facility, and shall be held responsible for any damage or 
vandalism incurred, including, but not limited to damage to the building, fixtures, 
furniture or equipment, as a direct result of their use.   

9. No school facilities, equipment or grounds shall be permitted for any of the 
following purposes: 



1-2 
 

a. Programs involving any form of gambling or other illegal activity. 

b. Programs which would be in violation of any law or School Board Policy. 

c. Adult entertainment which is sexually explicit or suggestive in nature, or which 
involves excessive profanity. 

d. Programs which promote activities which violate the law. 

10. Forty percent (40%) of the rental fee must be transmitted to the Finance 

Department to cover operational and maintenance costs.   

11. Responsibilities: 

a. Principal:  Identifies the school’s Facility Usage Designee and verifies that 
policies and procedures are being adhered to for all facility usage. 

b. Facility Usage Designee and/or Bookkeeper:  Coordinates   
i. use of facilities using EMS software 

ii. payment of employees (see Staff Requirements) 

iii. invoicing the renter 

iv. payment of the district’s portion (40% of facility usage only) 

v. remittance of sales tax to the Department of Revenue 

c. Finance Department:  Once Finance receives a completed Indemnification 
and Hold Harmless form, proof of insurance (in compliance with Policy 705), 
and certificate of sales tax exemption (if applicable) from a group requesting 
use of school facilities, the group will be entered into EMS.  This will allow the 
group to request use of any school’s facilities, with approval from the 
principal.   

d. Staff Requirements:  The District reserves the right to require provision of 
and payment for additional security, crowd control, custodial services, or other 
additional conditions as needed to ensure that use of school facilities for other 
purposes not detract from their primary educational use.  

i. A school district employee approved by the principal is required to be on 
the premises during the period of use, and where applicable, will be paid 
in accordance with the relevant collective bargaining agreement.  Any 
additional cost(s) for supervision and/or security services will be 
reimbursed by the outside organization.  This requirement shall not 
apply to pre-existing agreements with local governments.  

ii. The use of the school’s kitchen equipment for the preparation of food 
shall require the operation by a student nutrition service employee.   

iii. The use of technical equipment, such as the equipment in auditoriums 
and theaters, shall only be operated under the supervision of a school 
district employee.   
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12. School-based Organizations: Volunteer organizations generated by the 
existence of the school, such as booster clubs, parent-teacher organizations or 
associations, which are providing a service to the school.   

a. These organizations are permitted to use school district facilities without 
providing liability insurance or completing an Indemnification and Hold 
Harmless Agreement when the proceeds directly benefit a school or the 
district.  This waiver applies to activities on campus and does not extend off 
campus or to transportation.  This waiver cannot be assigned through a 
partnership or other agreement.   

b. With the approval of the Superintendent, a school based organization may be 
permitted to use school facilities on non-school and mandatory close dates, 
but may be required to reimburse the school board in accordance with the fee 
schedule.   

c. Usage shall not interfere with regular school programs, school activities, or 
school functions. 

d. The organization shall comply with the District’s Code of Conduct.  Failure to 
comply may result in the termination of the use agreement.  

e. The principal shall have the authority to deny use of a facility when he/she 
determines that the school district’s interest in maintaining a safe and secure 
environment for the students is best served by denying the request.   

f. The District reserves the right to require provision of and payment for 
additional security, crowd control, custodial services, or other additional 
conditions as needed to ensure that use of school facilities for other purposes 
not detract from their primary educational use.  

g. All users will be charged for any additional services provided as a result of 
their usage.  Additional services may include custodial, school nutrition, 
security, technical support, etc.  

13. Outside Organizations:  Organizations not generated by the existence of the 
school or the district, including for-profit users (including individuals), community 
groups, governments, and non-profit users.  This includes employees 
conducting their own activity as an independent contractor or agent, where the 
activity is not required as part of the employee’s employment with the school 
district.   

a. Outside organizations must provide the following to the Finance Department 
for approval to use a facility: 

i. Completed and signed Indemnification and Hold Harmless Agreement 

ii. A current certificate of liability insurance, which clearly states the 

organization’s liability coverage, naming the School Board as an additional 

named insured and certificate holder.   
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1. The liability insurance carried by the user must have limits of at least 
one million dollars ($1,000,000) for injury to any one person and two 
million dollars ($2,000,000) aggregate.   

2. Government agencies may comply with this requirement by providing 
a certificate of self-insurance, and are not required to have the school 
board named as an additional insured.   

b. Usage shall be reimbursed in accordance with the fee schedule and shall be 
discounted by 10% (hourly rate) for usage of twenty (20) hours or more per 
week, with a week being Sunday through Saturday.   

c. All users will be charged for any additional services provided as a result of 
their usage.  Additional services may include custodial, school nutrition, 
security, technical support, etc.  

d. Outside organizations may be permitted to use school facilities on non-school 
and mandatory close dates, but shall be required to reimburse the school 
board in accordance with the fee schedule.  For non-school day and 
mandatory close dates, an additional hour at the room rate is charged for air 
conditioning preparation. Usage shall not interfere with regular school 
programs, school activities, or school functions. 

e. The organization shall comply with the District’s Code of Conduct.  Failure to 
comply may result in the termination of the use agreement.  

f. The principal shall have the authority to deny use of a facility when he/she 
determines that the school district’s interest in maintaining a safe and secure 
environment for the students is best served by denying the request.   

g. The District reserves the right to require provision of and payment for 
additional security, crowd control, custodial services, or other additional 
conditions as needed to ensure that use of school facilities for other purposes 
not detract from their primary educational use.  

i. A school district employee approved by the principal is required to be on 
the premises during the period of use, and where applicable, will be paid 
in accordance with the relevant collective bargaining agreement.  Any 
additional cost(s) for supervision and/or security services will be 
reimbursed by the outside organization.  This requirement shall not 
apply to pre-existing agreements with local governments.  

ii. The use of the school’s kitchen equipment for the preparation of food 
shall require the operation by a student nutrition service employee.   

iii. The use of technical equipment, such as the equipment in auditoriums 
and theaters, shall only be operated under the supervision of a school 
district employee.   

h. Cancellations not made within two (2) business days of the initial event may 
be subject to a cancellation fee.  The cancellation fee will be equal to the 
minimum usage fee in accordance with the fee schedule.  Excessive 
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schedule changes may result in an administrative fee being assessed by the 
school district.  Non-payment, absent the existence of extenuating 
circumstances, will result in denial of future use of any facility.   

i. If an applicant’s payment is rejected due to insufficient funds, the applicant 
may not use the facility until debt is settled.   

j. All outside organizations using school district facilities must make known that 
neither the school board nor the administration has endorsed the users’ 
activities.  Any advertisement or circular must contain specific language to 
that effect.  The suggested disclaimer is:  “Volusia County Schools does not 
specifically endorse or support the program or individuals involved in 
“______________”.   

k. Organizations which fail to comply with the terms of the agreement will be 
denied further use of school district facilities.   

14. Indemnification and Hold Harmless:  All outside organizations using district 
facilities must complete and sign the VCS Indemnification and Hold Harmless 
Agreement that shall hold the School Board, its members, employees and 
representatives harmless from any claims, injuries or damage occurring while 
the organization is on premises.  Indemnification agreements shall only be 
required from governmental agencies to the extent allowed by the State’s 
sovereign immunity laws.   

15. Insurance Requirements:  All outside organizations must provide a current 

certificate of liability insurance, which clearly states the organization’s liability 

coverage, naming the School Board as an additional named insured and 

certificate holder.   

a. The liability insurance carried by the user must have limits of at least one 
million dollars ($1,000,000) for injury to any one person and two million 
dollars ($2,000,000) aggregate.   

b. Government agencies may comply with this requirement by providing a 
certificate of self-insurance, and are not required to have the school board 
named as an additional insured.   

c. As an alternative to requiring evidence of liability insurance, the 
superintendent may authorize the purchase of a Tenant Users Liability 
Insurance Policy (TULIP), and the require the users to purchase the 
insurance from the district.  

d. Activities with a high potential for accidents or liability will not be permitted.   

16. Code of Conduct:  The organizations using the school district facility shall 
enforce compliance with the following standards: 

a. The use of tobacco, alcohol or other drugs is not permitted on school board 
owned property. 
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b. Parking shall only be in clearly marked parking spaces. 

c. The area shall be left clean and ready for students.  Trash or debris shall be 
picked up and disposed of properly.   

d. The organization shall check to see if the property is secure when departing, 
leaving it the same as they found it. 

e. The organization shall be sure to conduct play activities in a sportsman-like 
manner.  No fighting or roughhousing will be allowed. 

f. The organization shall report any unsafe conditions to the school-based 
administrator as soon as noted. 

g. No firearms or weapons of any kind shall be brought onto the premises. 

h. The Code of Student Conduct will apply to students participating in the 
activity.   

17. Fee Schedule:  The fee schedule lists charges by hour. Minimum usage is for 
one hour with ½ hour increments thereafter.  

a. For non-school day usage, an additional hour at the room rate is charged for 
air conditioning preparation. Please list this as a separate line item on the 
agreement. If air conditioning was not turned on, this additional hour should 
be removed and the room fee reduced by 10%.  

b. Restrooms are included in the fee rates and are to be made available for the 
stated hours of all agreements. 

c. Changes made to the fee schedule are typically effective July 1 of the new 
fiscal year. The current fee schedule is located on the Finance Department’s 
web page. Please check regularly to verify that you are quoting the correct 
rental rate(s) to potential renters. 

18. Discounts/Considerations:  A discount of 10% (off of hourly rental rate) should 
be given for usage over 20 hours in week. A “week” is Sunday through 
Saturday.   Consideration may be given by the principal, with approval of the 
superintendent, to accept use of outside facilities, services, repairs or purchase 
of equipment in lieu of the school’s share of the rental fee or a portion thereof. A 
separate use agreement must be executed outlining the detailed terms of such 
an agreement and must accompany the Facility Usage Agreement. 

19. Non-school/Mandatory Close Dates:  Organizations may be permitted to use 
school facilities on non-school and mandatory close dates.  School-based 
organizations MAY be required to reimburse the school board in accordance 
with the fee schedule.  Outside organizations SHALL reimburse the school 
board in accordance with the fee schedule.  For non-school days and mandatory 
close dates, an additional hour at the room rate is charged for air conditioning 
preparation. 

20. Non-payment:  All fees must be paid in accordance with the terms as set forth 
in the usage agreement. 
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a. It is suggested that pre-payment be required for “one-time” renters. 

b. Renters that fail to comply with the terms of the agreement shall be denied 
further use of all school district facilities. 

c. If a renter’s payment is rejected due to insufficient funds the renter may not 
use the facility until debt is settled. 

21. Sales Tax:  Each renter that is not exempt from paying Florida Sales Tax will be 
invoiced sales tax on the rental portion of each invoice. The renter must supply 
a copy of the current exemption certificate to the Finance Department in order to 
avoid being charged sales tax.  Please refer to the Internal Accounts 
Procedures Manual for instructions on how to pay sales tax collections to the 
Department of Revenue. 

22. Approval Procedure:  Organizations/Individuals interested in using a school 
facility will normally contact the school.   

a. Outside Organizations must first register with the Finance Department by 
using the Volusia County Schools website.   

i. On the home page, click on the “Departments” tab. 

ii. Under Financial Services, choose “Finance”. 

iii. From the Finance Department’s website, choose “Facility Usage” from 
the menu on the left side of the screen. 

iv. On the Facility Usage window, choose the “Facility Usage Hold 
Harmless Agreement”.  Complete, print and sign this form. 

v. Submit the Facility Usage Hold Harmless Agreement, a copy of a current 
certificate of liability insurance with the required coverage, and a copy of 
a valid Consumer’s Certificate of Exemption (if applicable) to the 
Finance Department via  

Email to: Finance@volusia.k12.fl.us 
or fax:  386-943-3428 
or mail:     School District of Volusia County 
         Attn:  Finance Department 
         P.O. Box 2118 
         DeLand, Florida  32721-2118 

vi. Once the outside organization has been approved by the Finance 
Department, the organization may contact or submit a Facility Usage 
Request (also available on the Finance Department’s website) to any 
school they have an interest in using.   

vii. Instructions (Steps to Requesting Use of School Facilities) are available 
on the Finance Department’s website.   

b. School-based organizations may need to be added into EMS by the Finance 
Department.  Please contact Finance for guidance. 
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c. VCS employees do not require approval from the Finance Department.  When 
entering a reservation in EMS for school-based events requested by an 
employee, choose the employee’s name from the “Group” drop down list.   

23. Reserving Facilities:  Schools use the EMS (Event Management Systems) 
software to manage the use of their facilities.  The software allows the school to 
view space availability, charge outside organizations rental rates in accordance 
with the fee schedule and resources (custodial, VCS employee representative, 
utilities, food, etc.), and send confirmations and invoices via email.   

a. The EMS software is programmed to charge outside organizations based on 
the fee schedule but not to charge school-based organizations or employees.   

b. Room rates, custodial fees, VCS employee representative fees, technician 
fees, lighting charges, air conditioning charges, and sales tax (when 
applicable) are all programmed into EMS so that the user doesn’t have to 
calculate anything.   If a booking is canceled, EMS will not charge for it.     

c. Refer to the remaining chapters of this manual on how to reserve a room, 
email a confirmation, make cancellations, email invoices, and record 
payments. 

24. Invoicing/Fee Collection:   

a. Each school site invoices the renter directly for usage and any other fees 
(custodial, representative, sales tax, etc) using the EMS software.   

i. EMS calculates the charges based on the District’s Facility Usage Fee 
Schedule and rooms & additional charges (utilities, personnel, etc.) 
selected.   

ii. For details on how to generate invoices via EMS, please refer to the 
“Billing” chapter of this manual.    

b. Upon receipt of payment: 

i. Write a receipt to the renter. 

ii. Record payment in EMS.  For details, please refer the “Billing” chapter of 
this manual. 

iii. Complete a Monies Collected Form and turn in with cash/check and a 
copy of the invoice to the Internal Accounts bookkeeper.  The 
bookkeeper will deposit the sales tax portion to the sales tax trust 
account (6700.000) and the remaining amount to the Facility Usage 
Account (7650.000). If usage income needs to be recorded by separate 
area used (gym, auditorium, etc) the internal accounts bookkeeper 
should request extension accounts. 

iv. Request payment of district portion (40% of facility usage only).  For 
payment documentation, a copy of invoice can be used.  An EMS report 
can also be generated that will break down an invoice by facility usage, 
personnel, and sales tax.   

v. Send a copy of the invoice or report along with the payment to Finance.  
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25. Payment of Employees:  Some facility usage is outside of normal business 
hours and requires school representative(s) to work additional hours outside 
of his/her normal scheduled hours. These additional hour(s) must be reflected 
in the appropriate pay period worked so that the employee is paid according 
to his/her contract.  

a. Employees are not to be paid directly from a renter. Payment is to be 
made from internal accounts – Facility Usage 7650.000 – to the Payroll 
Department.  

b. Each payment must include the employee’s salary plus taxes and 
benefits.   

c. Please note the following excerpt from the AFSCME contract: Article XVI, 
D – Special Functions, “School Way Café’ employees who work on special 
functions, funded by a business or agency outside the school system, in 
addition to their regularly assigned work hours shall be compensated at a 

rate of time and one�half (1 ½) of their normal rate of pay. Payment will 
be made in a timely fashion – not to exceed four (4) weeks.”  The overtime 
is paid regardless if the SWC employee has worked a 40-hour week or 
not. 

d. A Payroll invoice will assist in the calculation of the total due to the district 
and must accompany the payment. This form can be found and completed 
on the Payroll Department’s webpage.  

e. Questions regarding Payroll Invoices should be referred to the Payroll 
Department. 

26. Use of Income:  After expenditures existing as a result of the rental have been 
paid (payroll invoices, district portion of rental fees and sales tax), income 
remaining from facility usage may be used for the following: 

a. Upkeep or repair of the facility 
b. Campus beautification 
c. Supplies 
d. Authorized salary supplements 
e. Student recognition programs and activities 
f. Staff recognition program and activities 
g. General internal account expenditures which would benefit the student body 

as a whole 
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   Volusia County Schools Facility Usage Fee Schedule* 

  FACILITY TYPE 
FEE/HR 

Effective 7-1-08 

CAMPUS - Interior   

  Classroom-up to 1,000 sq. ft. 16.00 

  Classroom over 1,000 sq. ft. and Portables 24.00 

  Media Center 30.00 

  Cafeteria/Auditorium-Elementary Schools 35.00 

  Cafeteria/Gymnasium/Auditorium-Middle Schools 40.00 

  Cafeteria - High Schools 67.00 

  Auditorium-High Schools 120.00 

  Gymnasium-High Schools (Except Mainland) 80.00 

  Gymnasium-Mainland High - Lower Level 80.00 

  Gymnasium-Mainland High - Upper Level 90.00 

NOTES:   

  Add one hour air conditioning preparation charge for Saturdays, Sundays and non-school days 

  Restrooms are included with facility usage   

      

CAMPUS - Exterior   

  Game Field/Track/Stadium - High School 60.00 

  Practice Field - Middle and High School 18.00 

  Other exterior areas - All schools 15.00 

  Auxiliary Lighting (except parking lots) 70.00 

      

PERSONNEL - Per Person**   

  Technician 33.00 

  Custodian (setup/breakdown/cleanup) 26.00 

  VCS employee representative 26.00 

** Required level of service of staff to be determined by the site administrator 

*In accordance with VCSB Policy 705 
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     INDEMNIFICATION AND HOLD HARMLESS AGREEMENT 

      COMMUNITY USE OF SCHOOL FACILITIES (POLICY 705) 

 

Name of Organization:               

      * 

FEIN:       Tax Exemption Certificate #:     

Contact Name:    Phone#:    

Address:      

City:   State:       Zip Code:    

Email:       

 * Please note:  Sales tax (6.5%) must be collected unless a valid Consumer’s Certificate of Exemption is    

provided 

The above named user (hereinafter referred to as the “Releasor”) of Volusia County School Board property for 

itself, its employees, agents or servants hereby agrees to indemnify and hold harmless the School Board of 

Volusia County, Florida, its members, employees, agents or servants (hereinafter collectively referred to as the 

“School Board Releassees”), for any loss which  School Board Releasees  may suffer as a result of any claim, 

action or lawsuit which may be brought against it by any person or persons claiming injury to person or 

property, including intellectual property resulting in any way from the use of Volusia County School Board 

property by Releasor, its agents, servants, invitees and/or employees. 

It is hereby understood that the obligation of indemnification will be enforceable by the School Board of Volusia 

County, Florida, notwithstanding the fact that any claim or damage to person or property be resolved by mutual 

agreement of the School Board of Volusia County and the person or persons claiming injury to person or 

property.  The School Board expressly retains all rights, benefits and immunities of sovereign immunity in 

accordance with Section 768.28, Florida Statutes. Notwithstanding anything set forth in any section of this 

Agreement to the contrary, nothing in this Agreement shall be deemed as a waiver of immunity or limits of 

liability of the School Board beyond any statutory limited waiver of immunity or limits of liability which may have 

been adopted by the Florida Legislature or may be adopted by the Florida Legislature and the cap on the 

amount and liability of either party for damages, attorney’s fees and costs regardless of the number or nature of 

claims in tort, equity or contract shall not exceed the dollar amount set by the legislature for tort. 

Indemnification will include in addition to any sums paid to the claimant, any attorney fees, litigation costs or 

other charges sustained by the School Board of Volusia County as a direct result of the negligent and/or 

intentional conduct of the user, its agents, servants, invitees and/or employees. 

 

ORGANIZATION REPRESENTATIVE (PRINT)     TITLE 

 

ORGANIZATION REPRESENTATIVE (SIGN)     DATE 
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FACILITY USAGE REQUEST 

 

 
Applicant Information: 
 
Name of School  

Requested:      School Contact:         

  

Name of Organzation:    

 

Applicant Name:   Email Address:        

 

Describe Event/Activity:            

 

           

 

           
 

Room Request: 
 

Type of room requested                              Date(s) Day(s) of Week Times Hours 
(or specific Bldg/Rm #) Start End Su M T W T F Sa Start End per Day 

        

             

             

             

             

             

             

             

             
 

Notes:  Include in notes any special instructions or additional services (custodial, AV, lighting, etc.) needed: 

 

           

 

           

 

           

 

           

 
 

 
___________________________________             ___________________________ 
               Applicant Signature                 Date 

 
 
___________________________________             ___________________________   

         Principal/Designee Signature                        Date 
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FISCAL MANAGEMENT POLICIES        NUMBER 705 

 

COMMUNITY USE OF SCHOOL FACILITIES 

 

The School Board recognizes that use of the district's facilities by outside organizations can benefit the general public of 

Volusia County. The School Board believes that the school district facilities should be made available for community 

purposes, provided that such use does not detract from the original and necessary purpose of the property or interfere with 

the educational program of the schools. The Superintendent may authorize the use of school district facilities by outside 

organizations, in accordance with the terms of this policy. The participation by outside organizations in events that take 

place during school hours as part of a school’s educational operation shall not constitute the use of a school district facility 

under the terms of this policy.  School district facilities shall not be considered public forums, unless so designated by the 

district. 

 

I. Definitions 

 

A.  School-based organizations - those volunteer organizations generated by the existence of the school, such as 

booster clubs, parent-teacher organizations or associations, which are providing a service to the school. All 

school-based organizations must comply with the requirements for “outside support organizations” set out in 

School Board Policy 719, Internal Accounts.   

B.  Outside organizations - those organizations not generated by the existence of the school or the district, including 

for-profit users (including individuals), community groups, governments, and non-profit users. This includes 

employees conducting their own activity as an independent contractor or agent, where the activity is not 

required as part of the employee’s employment with the school district. 

C.  Superintendent - Superintendent or designee 

D.  School district facility – any facility and the grounds of such facilities (1) owned or leased by the school board; 

and (2) operated by the school board. 

II. Fee Structure, Payments, and Use of the Income 

A.  All outside organizations using school district facilities shall reimburse the school board in accordance with the 

fee schedule developed by the Superintendent pursuant to this policy. The Superintendent will determine the fee 

schedule based on a review of operational and maintenance costs. Prevailing rates may also be considered. A 

ten percent (10%) discount shall be given to organizations using a facility for twenty (20) or more hours per 

week, with a “week” being Sunday through Saturday.   

B.  All users will be charged for any additional services provided as a result of their usage. Additional services may 

include custodial, school nutrition, security, technical support, etc. 

C.  If an outside organization’s check was rejected due to insufficient funds, then any future checks from that 

outside organization cannot exceed $250. 

D.  Twenty-five percent (25%) of the listed rental fee will be transmitted to the finance department of the district to 

cover operational and maintenance costs. As of July 1, 2009, that amount shall be increased to forty percent 

(40%). This increase shall not impact any pre-existing agreements with local governments. 

E.  Consideration may be given by the school principal, with approval of the superintendent, to accept use of 

outside facilities, services, repairs, or purchase of equipment in lieu of the school’s share of the rental fee or a 

portion thereof. A use agreement will be executed outlining the terms of such an agreement.  

F.  Florida sales tax, when required, will be collected at the school. 
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FISCAL MANAGEMENT POLICIES        NUMBER 705 

 

G.  Income from leased facilities may be used on upkeep or repair of the leased facility, campus beautification, 

supplies, authorized salary supplements, student recognition programs and activities, staff recognition programs 

and activities or general internal account expenditures which would benefit the student body as a whole. 

III. Fee and Insurance Waivers 

A.  School-based organizations may be permitted to use school district facilities without providing liability 

insurance or completing a facility usage agreement in accordance with School Board Policy 719 Internal 

Accounts. This waiver applies only to activities on campus and does not extend off-campus or to transportation. 

This waiver applies only to activities whose proceeds directly benefit a school or the district, and cannot be 

assigned through a partnership or other agreement. 

B.  Any existing agreements between the School Board, a booster or volunteer group, or governmental agency shall 

govern facility usage as stated in the agreement and can only be terminated as provided within the agreement. 

The use of a school district facility by the County of Volusia as an emergency shelter shall not require a fee. 

C.  With the approval of the Superintendent, a school based organization may be permitted to use school facilities 

during mandatory close dates, but may be required to reimburse the school board in accordance with the fee 

schedule developed by the Superintendent pursuant to this policy. Outside organizations may also be permitted 

to use school facilities during mandatory close dates, but shall be required to reimburse the school board in 

accordance with the fee schedule developed by the Superintendent pursuant to this policy. 

IV. Terms and Conditions for Facility Use 

A. Requests for use shall be presented to the principal to recommend approval or denial. The principal shall ensure 

compliance with procedures developed by the superintendent. Use of a school district facility by school-based 

organizations and outside organizations shall not interfere with regular school programs, school activities, or 

school functions. In addition, the principal shall have the authority to deny use of a facility when he or she 

determines that the school district's interest in maintaining a safe and secure environment for the students is best 

served by denying the request.  

B. All outside organizations seeking to use a school district facility shall be required to complete a facilities usage 

agreement prepared by the superintendent. The agreement must be completed and the original returned to the 

school no less than twenty-one (21) calendar days prior to the initial use of the school district facility by the 

organization under the agreement. All fees must be paid in accordance with the terms set out in the facilities 

usage agreement. Organizations which fail to comply with the terms of that agreement will be denied further 

use of school district facilities. 

C. Any facilities usage agreement shall not go beyond the expiration of the fiscal year in which the agreement is 

executed unless approved by the school board, or where the agreement is pursuant to an interlocal agreement 

approved by the  school board. 

D. All users shall comply with the school district's Code of Conduct set forth in Section VI. Failure to comply may 

result in termination of the use agreement. 

E. The use of the school’s kitchen equipment for the preparation of food shall require the operation by a student 

nutrition service employee. 
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F. The use of technical equipment, such as the equipment in auditoriums and theaters, shall only be operated under 

the supervision of a school district employee. 

G. The school board reserves to itself and the superintendent the right to require provision of and payment for 

additional security, crowd control, custodial services, or other additional conditions as needed to ensure that use 

of school facilities for other purposes not detract from their primary educational use. 

H. All outside organizations using school district facilities must make known that neither the school board nor the 

administration has endorsed the users' activities. Any advertisement or circular must contain specific language 

to that effect. The suggested disclaimer is: "Volusia County Schools does not specifically endorse or support the 

program or individuals involved in “____________.” 

I. A school district employee approved by the principal is required to be on the premises during the period of use, 

and, where applicable, will be paid in accordance with the relevant collective bargaining agreement. Any 

additional cost(s) for supervision and/or security services will be reimbursed by the facility user. This 

requirement shall not apply to pre-existing agreements with local governments. 

J. All facility use agreements for one year or less must be approved by the superintendent. Lease agreements for 

more than one year must be approved by the school board. All active use agreements will remain in effect until 

the expiration date or a breach of contract by the lessee. 

K. Organizations and individuals using school district facilities must take proper and ordinary care of the facility, 

and shall be held responsible for any damage or vandalism incurred, including but not limited to damage to the 

building, fixtures, furniture or equipment, as a direct result of their use. 

L. Cancellations not made within two (2) business days of the initial event may be subject to a cancellation fee. 

The cancellation fee will be equal to the minimum usage fee in accordance with the fee schedule. Excessive 

schedule changes may result in an administrative fee being assessed by the school district. Nonpayment, absent 

the existence of extenuating circumstances, will result in denial of future use of any facility. 

V. Insurance, Indemnification and Liability 

A. Prior to use of school district facilities, the identified user must provide a current certificate of liability (copy of 

insurance) which clearly states the organization's liability coverage, naming the School Board as an additional 

named insured and certificate holder. Government agencies may comply with this requirement by providing a 

certificate of self-insurance, and are not required to have the school board named as an additional insured. 

B. The liability insurance carried by the user must have limits of at least one million dollars ($1,000,000) for injury 

to any one person and two million dollars ($2,000,000) aggregate. 

C. As an alternative to requiring evidence of liability insurance, the superintendent may authorize the purchase of a 

Tenant Users Liability Insurance Policy, and then require users to purchase the insurance from the district.  

D. The principal must submit the original indemnification/hold harmless agreement and insurance certificate to the 

superintendent prior to the use of the facility. 

E. Activities with a high potential for accidents or liability will not be permitted. 

F. All outside organizations using school district facilities shall execute an indemnification and hold-harmless 

agreement which shall hold the school board, its members, employees and representatives harmless from any 

claims, injuries or damage occurring while the organization is on the premises. Indemnification agreements 

shall only be required from governmental agencies to the extent allowed by the state’s sovereign immunity 

laws. 
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VI. Code of Conduct on School Board Property 

The organization using the school district facility shall enforce compliance with the following standards: 

A. The use of tobacco, alcohol or other drugs is not permitted on school board owned property. 

B. Parking shall only be in clearly marked parking spaces. 

C. The area shall be left clean and ready for student’s. Trash or debris shall be picked up and disposed of properly. 

D. The organization shall check to see if the property is secure when departing, leaving it the same as they found it.  

E. The organization shall be sure to conduct play activities in a sportsman-like manner. No fighting or 

roughhousing will be allowed. 

F. The organization shall report any unsafe conditions to the school-based administrator as soon as noted. 

G. No firearms or weapons of any kind shall be brought onto the premises. 

H. The Code of Student Conduct will apply to students participating in the activity. 

VII. Uses of School District Facilities 

No school facilities, equipment or grounds shall be permitted for any of the following purposes: 

A. programs involving any form of gambling or other illegal activity; 

B. programs which would be in violation of any law or School Board Policy; 

C. adult entertainment which is sexually explicit or suggestive in nature, or which involves excessive profanity; 

D. programs which promote activities which violate the law. 

 

Legal Authority: 

 Sections 1001.41, 1001.42, Florida Statutes 

Laws Implemented: 

 Section 1003.01, Florida Statutes 

History: 

 (Adopted -- December 17, 1974) 

 (Revised -- June 10, 1980; March 11, 1986; August 25, 2009) 

(Effective Date -- July 1, 2009) 
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Chapter 2 
Reservations 

 

1. An event in EMS is comprised of the following: 

a. A reservation – the WHO and the WHAT of an event.  For example, XYZ 

Tutoring (the who) is reserving some space for tutoring sessions (the what). 

b. One or more bookings – the WHERE and the WHEN of an event.  For 

example, XYZ Tutoring is reserving classroom 001 (the where) on Tuesday from 

2:30pm to 3:30pm (the when).  This would be one reservation with one booking.  

If XYZ Tutoring reserved a classroom for every Tuesday, then this would be one 

reservation with multiple bookings.   

c. Booking details – the resources or services that are needed for the event, notes 

regarding the event, room charges, etc.  For example, XYZ Tutoring requires 

after school snacks (resource) and will be charged $16 an hour (room charge).   

2. All events have a timeline: 

a. Event Time – The time period during which the event actually takes place. 

b. Setup/Teardown Time – The time added to the event to allow staff to prepare a 

room for the event or to clean up after the event.  For example, the extra hour for 

A/C on non-work days would fall under this category. 

c. Reserved Time – The total time the space is reserved (event time plus the 

setup/teardown time). 
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3. Making a reservation using the Reservation Wizard. 

a. Certain settings in the Reservation Wizard can have defaults set to make 

reserving rooms easier.  The application automatically starts event times with 

12:00AM. If most of your reservations occur after school, you may want to 

change the default times to 2:00PM.  To change the defaults, choose Settings 

from the Menu bar > Preferences > Defaults tab.  Set the event times and the 

time zone (Eastern Time) as shown below: 

 

b. On the toolbar, click on the Wizard icon as shown below: 

 

c. The calendar is similar to the one we use in Outlook.  A different month can be 

chosen by clicking on the single arrows (< or >) and a different year is chosen by 

using the double arrows (<< or >>).  You can also click on the month at the top of 

the calendar to open a dropdown list of months to choose from.   

Change to desired 
default times 

Choose Eastern Time (ET)  
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d. Dates can be chosen directly from this calendar by clicking on the date(s).  When 

selecting several dates it isn’t necessary to hold the ctrl or shift key down.  To 

select all five days for a week, click on the blank space to the left of the week.  To 

select all seven days for a week, double-click in the blank space to the left of the 

week.  To select every occurrence of a day for a month, click on the heading 

(S,M,T,W,T,F,S).  To select every occurrence of a day for more than the month 

on the screen, doube-click the heading.   

 

 

 

To select the next 
month 

To select the next 
year 

Can select month 
from dropdown list 

Select by clicking 
on dates 

To select all five 
days click on the 
bank space next 
to the week.  To 
select all seven 
days double-click 
on the space.   

To select every 
Thursday for this 
month, click on the 
“T” heading.  To 
select every 
Thursday for 
multiple months 
double-click on the 
“T” heading.   
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e. If the dates follow a pattern (for example, the third Friday of every month), dates 

can be chosen using the Date Pattern button as shown below.  Choose the 

appropriate date patterns similar to the Recurrence option in Outlook. 

 

f. If any of the selected dates have been designated as a holiday or “special” day 

(e.g. FCAT weeks), the following message will appear.  Click on the OK button. 

 

This example chooses every 
Tuesday and Thursday for 
the months of January 
through April 
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g. Click on the Selected Dates tab to view all selected dates.  Holidays and special 

days are described next to the date.  Determine if the group is permitted to use 

the facility on that date.  If not, use the Remove button to unselect the date.   

 

 

  

h. Select the event time by either using the dropdown list next to each field or 

manually entering the time in the field.  When manually entering the time, you 

can use a shortcut method.  For example, for 9:00AM, enter only “9a” and for 

2:00PM, enter only “2p”.  If the end time is earlier than the start time, the system 

assumes that the end time is the next day and the phrase “Next Day” appears to 

the right of the End time field.  Remember to consider setup/teardown times 

when selecting the start and end times.   
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i. If you have a specific room that you want to reserve, Click on “Specific Room” 

and the Room Selector screen will pop up.  Select the desired room and click on 

the OK button.   

 

j. The specific building and room number will appear in the Room field.  Next to the 

status field choose Approved from the dropdown list.  PLEASE NOTE:  If this 

group is sharing the same room on the same date/time as another group, choose 

“shared space” as the status.  This will allow the room to be reserved by another 

group for this specific date/time.  Click on the Next button.   

 

Choose “Approve” 
unless the group is 
sharing the room – 
then choose “Shared 
Space” 
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k. A location can also be selected using the Standard and Best Fit methods.   

i. Standard is used to display a list of all the available rooms that meet all the 

requested dates. Choose the desired room type (e.g. classroom).  Choose 

Approved for the status and click on the Next button.  A list of available rooms 

appears.  Highlight the desired room(s) and click the single arrow (>) button to 

move the room(s) to the selected column.   

ii. Best Fit is used if no one room can meet all the requested dates.  The system 

lists rooms along with the number of bookings for which you can reserve the 

room.  You can piece together the entire reservation using Best Fit, or just 

part of it.  Choose the desired room type (e.g. classroom).  Choose Approved 

for the status and click on the Next button.  A list of available rooms appears.  

Highlight the desired room(s) and click the single arrow (>) button to move the 

room(s) to the selected column.   

l. If the room has already been reserved for that date/time, the following message 

will appear. Click on the OK button.  

 

m. The Conflict tab will list all dates that have already been reserved for this space.  

Click on the Previous button to return to the reservation screen or the Cancel 

button to cancel out of the reservation completely.  After clicking on the Previous 

button, make changes to the date, time or location and click on the Next button to 

proceed.   
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n. Once it has been determined that all requested space is available the following 

screen with appear.  All bookings will appear in the “Available” column.  Use the 

button with the double arrows (>>) to move them to the “Selected” column.  Click 

on the Next button as shown below.   

 
 

            

o. The next screen requires information about the event.  Fields with a large red dot 

next to them are required fields.  Type in the name of the event in the first field.  

Use the dropdown list next to the Event Type field and choose the type that best 

describes the event.  Choose the group requesting the space.  The dropdown list 

can be used or begin typing the group name or VCS employee’s last name and 

the field will automatically populate.  The search button (magnifying glass) can 

also be used. If the phone number does populate automatically one must be 

entered.  The phone number for a VCS employee would be the extension 
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number.  The Source field is optional, but is helpful to track how the reservation 

was requested.  

 

 

p. Click on the Billing tab and choose Check from the Payment Type dropdown list.  

Click on the Finish button. 

 

q. The complete reservation will appear on the screen.   

Enter Event Name 

Choose the appropriate type 
Begin typing the group name or 
VCS employee’s last name and 

the field will automatically 
populate 

Optional – Used to track how 
the reservation was requested 

Phone or extension number (VCS) 
if not automatically populated 

Choose Fixed Capacity 
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4. Adding Another Room (Booking) 

a. If another room is desired, right mouse click on the booking area as shown 

below.  

 

 

b. Repeat the steps above to choose the date, time, room, etc. The only information 

that doesn’t have to be entered is the group/contact information.  Once all 

requests have been made the reservation should look similar to the one below.   

 

 

Right mouse click in 
this area to create a 
“new booking” 

Reservation 

Bookings 
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5. Making a reservation using the Reservation Book. 

a.  To open the Reservation Book, on the toolbar, click on the book icon. 

  

b. The book automatically opens in the Daily view and all reservations scheduled in 

all buildings for the current day’s date are displayed.  Select the desired date. 

Select the room and use the mouse to drag & drop the time. 

 

c.  The Reservation Wizard screen appears with the date highlighted on the 

calendar and the time entered into the start and end fields.  Change the status to 

Approved and click the next button. 

 

Select date 

Select room 
Use mouse to drag & 
drop time 

Choose Approved from 
the status dropdown list 
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d. The next screen requires information about the event.  Fields with a large red dot 

next to them are required fields.  Type in the name of the event in the first field.  

Use the dropdown list next to the Event Type field and choose the type that best 

describes the event.  Choose the group requesting the space.  The dropdown list 

can be used or begin typing the group name or VCS employee’s last name and 

the field will automatically populate.  The search button (magnifying glass) can 

also be used. If the phone number does populate automatically one must be 

entered.  The phone number for a VCS employee would be the extension 

number.  The Source field is optional, but is helpful to track how the reservation 

was requested.  

 

 

Enter Event Name 

Choose the appropriate type 
Begin typing the group name or 
VCS employee’s last name and 

the field will automatically 
populate 

Optional – Used to track how 
the reservation was requested 

Phone or extension number (VCS) 
if not automatically populated 

Choose Fixed Capacity 
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e. Click on the Billing tab and choose Check from the Payment Type dropdown list.  

Click on the Finish button. 

 

f. The complete reservation will appear on the screen.  If another room is desired, 

right mouse click on the booking area as shown below.  

 

 

Right mouse click in 
this area to create a 
“new booking” 
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g. Repeat the steps above to choose the date, time, room, etc. The only information 

that doesn’t have to be entered is the group/contact information.  Once all 

requests have been made the reservation should look similar to the one below.   

 

 

h. Approved bookings should show up on the Reservation Book in green: 

 

i. The following is the color coding for bookings: 

i. Approved = Green 
ii. Requested = Orange 
iii. Conflict = Red 
iv. Shared Space = Blue 
v. Waitlisted = Coral 

Reservation 

Bookings 
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6. To Add a Resource (A/C, lighting, food, or personnel) to a Booking or Multiple 

Bookings 

a. Resources would be added for some of the following reasons: 

i. Air conditioning (A/C) would be added if the reservation is on a non-work 

day. The charge is based on one hour for the specified room type. 

ii. Auxiliary lighting would be added for an event occurring at night. 

iii. Food –After School Snacks are added for some SES tutoring sessions.   

iv. Personnel would be added if a custodian, technician, or a VCS 

representative is needed.   

b. In the left pane, select the reservation for which the bookings need added 

resources and in the Bookings pane, click on the Tools button.  

c. Choose Add Booking Details Wizard. 

 

d. On the Add Booking Details window, choose the appropriate category.   

Reservation selected 
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i. If A/C and Lighting is selected, the appropriate charge must be selected on 

the next screen.  Auxiliary lighting is accessed at one rate of $70 per hour.  

Air conditioning, however, is based on the hourly rate of the room.  Choose 

the room type from the Item listing.  Highlight the item on the left panel and 

use the single arrow (>) to move it to the right panel.  Click on the Next 

button.  The example below is for A/C on a classroom up to 1,000 sq. ft.   

 

Choose from one of 
these categories 
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ii.  If Food is selected, choose highlight the appropriate food resource on the left 

panel and use the single arrow (>) to move it to the right panel.  Click on the 

Next button.  The following example is for after school snacks for the SES 

tutoring program.  SES Tutors are charged $10 a week for after school snacks.  

NOTE:  Choose this option for only one booking a week.   

 

iii. If personnel are selected, four additional fields appear in the window.    

iv. Leave On Site as the default for the Service field. 

v. Click on the Reviewed field, and choose a specified start and end time for the 

required personnel.  For example, if a custodian is needed to clean up after an 

event , the start and end time would be after the event.  If a VCS employee is on 

site for supervision or a technician is hired to handle sound/sage lighting during 

the event, the start and end time would be the same as the event.  Click on the 

Next button. 
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vi. Highlight the appropriate type(s) of personnel from the left panel and use the 

single arrow (>) to move it to the right panel.  Click on the Next button.  The 

following is an example of an event that requires a VCS Employee 

Representative for the event. 

 

 

vii. The Select Bookings window opens.  This window displays all the bookings for 

the selected reservation with a date greater than or equal to the current day’s 

These fields must be filled in 
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date.  CTRL-click to select the bookings that require the resource.  Use Select 

All if all bookings require the resource.  Click on the Finish button. 

7.  Charging School-based Organizations for the Cost of Custodians. 

a. When the need arises to charge school-based organizations for the actual cost of 

custodians, choose the “Custodian – School Based Orgs Only” item.  This will 

charge the school-based organization the actual cost ($19.80 per hour) rather 

than the rate charged to outside organizations.  This rate should correspond with 

the invoice that will be received from Aramark.  Facilities will notify you of this 

charge upon receipt of the Aramark invoice.    
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8. Attaching a Flyer, Agenda, or Other Materials to a Reservation. 

a. Scan the material and save as a pdf document.   

b. Click on the reservation.  Click on the Attachments tab.  Enter a description of the 

attachment (e.g. Flyer, Agenda, Materials, etc) and click on the browse button 

(magnifying glass) to find the saved file. Choose the pdf document and click on 

the save button. 

 

c. Once the document has been attached, it can be viewed by clicking on the 

Attachment tab and then the View button.   

9. Adding Reservation to Outlook and Scheduling Others. 

a. To add a single booking to Outlook, highlight the booking and click on the Outlook 

button.  

.  

 

Click on the reservation 
Click on the Attachment 
tab 

Enter a description of the 
attachment 

Choose the pdf 
document 

Click on the booking 
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b. The booking will now appear in Outlook with the event name as the subject and 

the building/room number for the location.  The dates and times will also 

automatically populate.  If you would like to invite others, click on the Scheduling 

button and choose the appropriate participants.   

 

c. Once all participants have been selected, click on the send button. 
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10. Viewing and Editing Reservations in the Reservation Book 

a.  To open the Reservation Book, on the toolbar, click on the book icon. 

  

b. The book automatically opens in the Daily view and all reservations scheduled in 

all buildings for the current day’s date are displayed.  The book can also be 

viewed by week or month.  To view only rooms with bookings, click on the word 

“Filter” and click on Rooms with Bookings and click OK. 

 

c. Only rooms with bookings will appear.  Running the cursor over the booking will 

supply the details to the event.  The following is the color coding for bookings: 

i. Approved = Green 
ii. Requested = Orange 
iii. Conflict = Red 
iv. Shared Space = Blue 
v. Waitlisted = Coral 



2-23 
 

d. If your school has more than 100 rooms, you may not see them all at first.   To 

View More than 100 Rooms on the Reservation Book, click on the Options 

button: 

 
 

 
 

e. On the Book Options window, change the maximum number of rooms: 

 

 



2-24 
 

f. You can do one or more of the following to edit an existing reservation: 

How to: Do this: 

Change the setup time  Drag the left bar horizontally to a new 

time and click Yes in the Confirm 

Change box. 

Change the event time Drag the middle bar horizontally to a 

new time and click Yes in the Confirm 

Change box. 

Change the teardown time  Drag the right bar horizontally to a 

new time and click Yes in the Confirm 

Change box. 

Edit the reservation building, room, 

time, or both 

Drag and drop the reservation to a 

new room and/or to a new time and 

click Yes in the Confirm Change box. 

g. You can also right-click on a reservation and on the context menu that opens, 

select one of the following: 

Option Description 

Open Opens a reservation in the EMS 

Navigator 

Add to Personal Calendar Adds the reservation to your 

personal calendar in Outlook 

Move Forward Move the reservation date forward 

by one day or one week 

Move Backward Move the reservation date 
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backward by one day or one week 

Move to Specific Date Move the reservation to a specific 

date 

Change Status Change the status of the 

reservation 

Copy Bookings Opens the Copy Bookings Wizard.   

Swap Rooms Swap the room assignment of two 

events.  The swap option is 

applicable only for two events that 

have identical meeting patterns.  

Highlight Related Reservations Highlights the bookings that belong 

to the same reservation 

  

 

Right mouse click on the 
booking 

Choose from any of 
these options 
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11. How to find the size (square footage) of a room. 

a. Open the Reservation Book by clicking on the book icon on the toolbar. 

  

b. The book automatically opens in the Daily view.  Select the desired room by 

clicking on the description.   

 

Click on the desired room 
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c. On the Room Info window, click on the Room tab and scroll down to Square 

Feet. 

 

d. For classrooms up to 1,000 square feet, the fee is $16 per hour. 

e. For classroom over 1,000 square feet and portables, the fee is $24 per hour.   

12. How to Create a “Favorites” List of Rooms 

a. From the Reservation Book, click on the word “Filter” 
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b. Click on Specific Rooms and select the desired rooms.  Once all have been 

selected, click on the OK button. 

 

13. Finding and Making a Reservation for a Group. 

a. You can also make a reservation by finding a group in EMS and making a 

reservation for the group from the Groups window.  Click on the Groups icon on 

the toolbar and select the group.  

 

 

 

Use these search features to 
quickly find a specific group 

The columns and area can be 
widened or made smaller to enable 
better viewing of the descriptions 
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b.  At the top of the Groups window, click on New Reservation. 

 

c. The Reservation Wizard will appear.  Refer to “Making a reservation using the 

Reservation Wizard” above.   

14. Approving a Reservation Request. 

a. Reservation requests that come through Outlook are created with a status of 

“Requested”.  These reservations must be approved or canceled.  Once a 

reservation request has been entered by an individual, and email should be sent 

to you and the Dashboard Icon should turn red alerting you a reservation needs 

approval.   

 

b. In the Dashboard, check for any new notifications.  Either double click on the 

notification or select it and click on the Go To button. 
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c. In EMS a reservation consists of two elements:  a reservation (highest level) and 

bookings (detail level).  Highlight the reservation (top line on the left side).  This 

will allow you to see a Change Status button on the right side.  Click on the 

Change Status Button.   

 
 

d. In the Status field drop down list, choose Approved. Click on the Next button. 

 

 
  
e. Select the bookings.  If there is only one, verify that it is highlighted and click on 

the Finish button. 

 

Reservation 

Booking 

Choose Approved 
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f.  The next screen shows all changed bookings.  Click on the Close button. 

 

 
 
 
g.  To send a confirmation email to the requester, click on the Confirmation button. 

 

 
 

h. On the Email Options tab, uncheck the Attach Detailed Confirmation option since 
this is not a facility usage billing and click on the Email button at the lower right 
corner of the screen. NOTE:  Since options remain in effect until changed, you may 
want to go back and re-check the “Attach Detailed Confirmation” option for future 
facility usage billings after this email is sent.   

 

 
 

Uncheck this option 
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i. When the email message appears, verify the information and click on the Send 

button. 

 

 

 

j. The requester is notified via email that the room reservation has been approved. 

k. In the Book, approved reservations appear in green and requested reservations 
appear in orange.   

l. Once the reservation has been approved and a confirmation email sent to the 
requestor, return to the Dashboard and mark the notification as “Reviewed” to turn 
the Dashboard icon back to green. 

 

 
 

m. The notification should disappear and the Dashboard icon should turn green unless 
there are other reservations waiting to be approved.   

Requester 

Reservation number 

Reservation Details 

Notification of 
Approval 
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Chapter 3 
Navigator 

 

1. The Navigator is a window in EMS that allows you to view and manage all aspects of 

a reservation, including bookings and booking details.   

2. After creating a reservation using the Reservation Wizard, the reservation opens 

automatically in the Navigator.  It can also be manually opened by clicking on the 

icon in the toolbar. 

 

3. The Open Navigator window will reveal the most recent reservations accessed.  If 

you know the reservation number you wish to access, type it in the Reservation No. 

field and click on the OK button. 

 

If you know the 
reservation number, 
type it here 
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4. If you don’t know the reservation number, you can browse reservations by clicking 

on the Browse button and entering in the known information. Click on the Get Data 

button.     

 

5. The Results tab appears with all the reservations pertaining to the information 

entered.  Highlight the desired reservation and click on the Open button.   

 

Type any 
known 
information 
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6. The reservation will appear.  A top-level folder in the left pane is referred to as a 

Reservation Folder.  The folders located beneath the reservation folder are referred 

to as Booking Folders.  The folders that are located beneath a booking folder are 

referred to as Booking Detail Folders.   

 

7. The reservation folder contains the who and what information for a reservation.  The 

tabs in the upper right pane are as follows: 

 

 

a. Reservation Summary tab  - displays information such as event name, the group 

for which the reservation was made, the group contact name and phone number, 

and the reservation number.   

Reservation Folder 

Booking Folder 

Booking Detail 
Folder 

Tabs 



3-4 
 

b. Properties tab - displays the same information as the Reservation Summary plus 

the event type, the second group contact, the date the reservation was added, 

changed, etc.   

c. Reminders tab - displays any reminders that were created for the selected 

reservation.   

d. Comments tab - displays any text entries that were made for the selected 

reservation.  This may be used to document an occurrence such as a temporary 

rate reduction due to an error or an event.  

e. Attachments tab - displays any attachments that have been saved with the 

reservation.  This could be a meeting agenda or a flier.   

f. User Defined Fields tab - displays the additional fields that store custom data for 

a reservation.  These must be configured by the Finance Department. 

g. Transactions tab - displays any invoices that were generated for the selected 

reservation or any payments that were applied to the selected reservation.   

 

h. History tab - displays the history of the reservation – the date that a change was 

made, the user ID of the person who made the change, the field that was 

changed, the old field value and the new field value.   

i. Emails tab - displays any summarizing information for any emails that were sent 

via SMTP to the group for whom the reservation was made.  

Invoice generated 

Payment received 
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8. The bookings for the selected reservation are displayed in the Bookings pane (lower 

right pane) of the Navigator.  The colored rectangle next to the left of the booking 

indicates the booking’s status.  If a booking has been canceled, a canceled icon  

is displayed on the booking folder in both the Reservation (left) pane and the 

Booking pane.   

 

9. Booking folders contain the where and when information for the reservation.  If you 

can expand a booking folder, this indicates that details have been added to the 

booking.  The booking details are displayed in the Booking Details pane (the lower 

right pane) of the Navigator.   

Example of a reservation before expanding a booking folder: 

 

Bookings Pane 

Status rectangle 
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Example of a reservation with the first booking expanded and selected. 

 

 

10. When a booking folder has been selected in the left pane of the Navigator as shown 

above, the following tabs appear in the upper right pane: 

 

 

Click on the + to see the booking details 
or highlight the booking and see the 
details on the lower right pane 

Tabs 
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a. Booking Summary tab – displays information about the selected booking, 

including the event date, reserved times, event times, event name, etc. 

b. Properties tab – displays not only the same information as the booking summary 

tab, but also information such as the event type, the date the booking was added, 

changed, etc.  

c. Reminders tab – displays any reminders that were created for the selected 

booking.   

d. Comments tab – displays any comments that were made for the selected 

booking.  This may be used to document an occurrence such as the A/C not 

working.  

e. Attachments tab – displays any attachments that were saved with the booking.  

This could be an agenda or a flier.   

f. Drawings tab – displays a list of files that were attached to the selected booking. 

g. History tab – displays a list of changes made for the selected booking – the date 

the changes was made, the user who made the changes, etc.  

11. The Booking details appear in the lower right pane: 

 

a. Booking details (also called categories) are the services provided (such as A/V, 

lighting, or food), notes, attendees, and room charges.  In the example above, 

the food is actually after school snacks provided for SES tutoring.   
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12. The Navigator has three constant commands in the upper right hand corner.   

 

 

 

a. Print – for printing a confirmation, invoice, transaction report. or service order. 

b. Refresh – for refreshing the Navigator display based on the settings that you 

have specified in the Navigator Options dialog box. 

c. Settings – Options opens the Navigator Options dialog box in which you can 

specify such things as what is to be displayed in the Navigator, mouse actions, 

etc.   Confirmation Settings opens the box which provides a variety of options 

that you can specify for manual and automatic generation of a confirmation for a 

reservation or a booking.   

13. All other Navigator commands are available as buttons in the upper right pane and 

lower right pane of the Navigator.  The buttons that are available are dynamically 

updated based not only on the folder or item that is currently selected in the left 

pane, but also, what tab is open in the upper right pane.   

Commands 
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Buttons available with a reservation folder selected: 

 

Buttons available with a booking folder selected: 

 

 

Many of the same commands are also available when you right mouse click on a 

folder or item in the Navigator.   

14. Changing the Status of a Reservation 

a. You must have been granted the appropriate security access to change the 

status of a booking.  

Reservation selected 

Buttons available 

Booking selected 

Buttons available 
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b. In the left pane, select the reservation and on the Reservation Summary tab, 

click on the Change Status button. 

 

 

c. The Change Booking Status window appears.  On the Status dropdown list, 

select the new status for the bookings.  If you select any type of Canceled status, 

then three additional fields (Reason, Who Cancelled and Notes) are displayed.  

You must enter data in all three of these fields before you can continue in the 

Wizard.   

 

d. The next window displays all the bookings for the selected reservation with a 

date greater than or equal to the current day’s date and that do not have invoiced 

items.  By default all bookings are selected.   

e. To show all bookings, regardless of date, clear the check on Hide Old Bookings.  

This will display bookings with a date less than the current day’s date.   

Reservation selected 
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f. Select the booking or CTRL-click to select multiple bookings that are to have 

their status changed, and then click on the Finish button. 

 

15. Copying a Reservation 

a. An easy way to make a new reservation is to copy an existing reservation and 

then make any necessary changes.   

b. When you copy an existing reservation, you must provide a new start date and 

new status.  You can, however, copy the existing reservation reminders, 

comments, user-defined fields, and drawings as is and you can copy one or more 

or all the existing booking details.   

 

   

Uncheck to select dates 
older than the current date 

Uncheck to show 
cancelled bookings 

Reservation selected 
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c. The Copy Reservation screen has several options: 

Field Explanation 

Start Date If you are copying a reservation with multiple bookings, then 

the start date should be the date of the earliest booking for 

the existing reservation 

New Status The status for the new reservation 

Reconfirm Date You must enter a date if it is required for the new status you 

selected 

Conflict Status You must enter a conflict status in the event that the new 

bookings are in conflict with any existing bookings. 

Reconfirm Date You must enter a date if it is required for the new conflict 

status that you selected 

Copy Reminders 

Copy Comments 

Copy UDFs 

Copy Attachments 

Copy Drawings 

Leave the appropriate options selected to copy the existing 

items as is, or clear the option for each item that is not to be 

copied to the new reservation 

Copy Booking Details Select the booking details that are being copied (CTRL-click 

to select multiple details) or to select all the details for 

copying, click Select All.  Note:  By default, only active 

booking details are displayed.  To show inactive booking 

details for copying, click Show Inactive. 
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d. Make all the necessary selections and click on the Next button.  

 

e. The Select Bookings window opens.  This window displays all the bookings for 

the copied reservation.  CTRL-click to select the bookings that are begin 

recreated in the new reservation, or click Select All to select all the bookings and 

then click Finish.  A message opens indicating that the changes were made 

successfully.  Click OK.   
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f. The start date that you specified becomes the date of the first booking for the 

new reservation.   

g. When you copy multiple bookings, the bookings are simply copied and pasted as 

is – the bookings are not moved to a different room.   

h. Both the existing reservation and the new reservation are no displayed in the left 

pane of the Navigator.  The new reservation is assigned the next available 

number.  If any of the new bookings are in conflict with existing bookings, the 

conflict is indicated.   

16. Making Changes (cancelations or date/time or room moves) to a Booking 

a. In the left pane, select the booking that is being changed and on the Booking 

Summary tab in the upper right pane, click on the Edit button.    

 

b. Make any necessary changes and then click on the OK button. 

c. If you changed anything other than the date, time or location for a booking, the 

Booking window closes and you return to the Navigator, which now shows the 

updated information for the booking. 

d. If you changed the date, time, or location for a booking, a dialog box opens, 

warning you that critical booking information has changed and asking if you want 

to continue.  Click Yes.   

Booking selected 

This booking has booking 
details (A/C, food, etc.) 

Can change status 
here to “cancel” 

Can make date and 
time changes here 

Can make room 
changes here 
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17. Making Changes (cancelations or date/time or room moves) to Multiple 

Bookings 

a. Four wizards are available for changing the when and where information for 

multiple bookings in a reservation.   

i. Change Booking Date/Time Wizard 

ii. Change Booking Status Wizard (includes canceling multiple bookings in a 

single step) 

iii. Change Rooms Wizard 

iv. Change Miscellaneous Booking Information Wizard (includes type, setup 

type, and setup count) 

b. In the left pane, select the reservation for which the bookings are being changed 

and in the Bookings pane, click on the Tools button.  

 

 

c. To change the bookings date and/or time, click the Change Booking Date/Time 

Wizard and change the value for the date, time, or both.   

Field Explanation 

Date  

No Changes The default value 

Reschedule Booking Earlier Reschedule the bookings to an earlier date that 

Reservation selected 

4 Wizards to choose from 
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is based on the number of days that you specify. 

Reschedule Booking Later Reschedule the bookings to a later date that is 

based on the number of days that you specify. 

Reschedule Booking to 

Specific Date 

Reschedule the bookings to a new date that you 

specify. 

Time  

No changes The default value. 

End booking earlier Resets the event end time and the reserved end 

time to an earlier time, based on the number of 

hours that you specify. 

End booking later Resets the event end time and the reserved end 

time to a later time, based on the number of 

hours that you specify. 

Reschedule Booking Earlier Resets both the event start and end times and 

the reserved start and end times to an earlier 

time, based on the number of hours that you 

specify. 

Reschedule Booking Later Resets both the event start and end times and 

the reserved start and end times to a later time, 

based on the number of hours that you specify. 

Reschedule Booking to 

Specific Time 

Resets the following values based on the 

specific times that you select:  reserved start, 

event start, event end, and reserved end 

Set Setup/Teardown Resets the setup or teardown times based on 

the hours or minutes that you specify. 
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Start Booking Earlier Resets the event start time and the reserved 

start time to an earlier time, based on the 

number of hours you specify. 

Start Booking Later Resets the event start time and the reserved 

start time to a later time, based on the number of 

hours you specify. 

d. The Select Bookings window opens.  By default, this window displays all the 

bookings for the selected reservation with a date greater than or equal to the 

current day’s date.  CTRL-click to select the bookings that are being changed or 

click the Select All button and then click on the Finish button.   

e. The Change Booking Date/Time Results window opens.  This window displays a 

list of all the selected bookings, whether the date/time change was successful or 

not.  To view only the bookings for the selected reservation that were NOT 

successfully changed, select Show Unchanged Only.  To view the details for a 

specific booking that was changed, select the booking and then click on the Go 

To button.  Otherwise, click the Close button. 

18. To Add a Resource (A/C, lighting, food, or personnel) to a Booking or Multiple 

Bookings 

a. Resources would be added for some of the following reasons: 

i. Air conditioning (A/C) would be added if the reservation is on a non-work 

day. The charge is based on one hour for the specified room type. 

ii. Auxiliary lighting would be added for an event occurring at night. 

iii. Food –After School Snacks are added for some SES tutoring sessions.   

iv. Personnel would be added if a custodian, technician, or a VCS 

representative is needed.   

b. In the left pane, select the reservation for which the bookings need added 

resources and in the Bookings pane, click on the Tools button.  

c. Choose Add Booking Details Wizard. 
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d. On the Add Booking Details window, choose the appropriate category.   

 

i. If A/C and Lighting is selected, the appropriate charge must be selected on 

the next screen.  Auxiliary lighting is accessed at one rate of $70 per hour.  

Air conditioning, however, is based on the hourly rate of the room.  Choose 

the room type from the Item listing.  Highlight the item on the left panel and 

use the single arrow (>) to move it to the right panel.  Click on the Next 

button.  The example below is for A/C on a classroom up to 1,000 sq. ft.   

Reservation selected 

Choose from one of 
these categories 
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ii.  If Food is selected, choose highlight the appropriate food resource on the left 

panel and use the single arrow (>) to move it to the right panel.  Click on the 

Next button.  The following example is for after school snacks for the SES 

tutoring program.  SES Tutors are charged $10 a week for after school snacks.  

NOTE:  Choose this option for only one booking a week.   

 

iii. If personnel are selected, four additional fields appear in the window.    

iv. Leave On Site as the default for the Service field. 
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v. Click on the Reviewed field, and choose a specified start and end time for the 

required personnel.  For example, if a custodian is needed to clean up after an 

event , the start and end time would be after the event.  If a VCS employee is on 

site for supervision or a technician is hired to handle sound/sage lighting during 

the event, the start and end time would be the same as the event.  Click on the 

Next button. 

 

vi. Highlight the appropriate type(s) of personnel from the left panel and use the 

single arrow (>) to move it to the right panel.  Click on the Next button.  The 

following is an example of an event that requires a VCS Employee 

Representative for the event. 

These fields must be filled in 
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vii. The Select Bookings window opens.  This window displays all the bookings for 

the selected reservation with a date greater than or equal to the current day’s 

date.  CTRL-click to select the bookings that require the resource.  Use Select 

All if all bookings require the resource.  Click on the Finish button. 

19. To Delete a Resource (A/C, lighting, food, or personnel) to a Single Booking 

a. In the left pane, select the resource to be deleted, right mouse click, and choose 

Delete as shown below. 

 
 

b. You will be asked if it is OK to delete the booking detail.  Click on Yes. 

Reservation selected 

Choose Delete 

Use these buttons to drill 
down to a resource 
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c. The resource will be removed from the reservation as shown below. 

 

 
 

20. To Delete a Resource (A/C, lighting, food, or personnel) to Multiple Bookings 

a. In the left pane, select the reservation for which the bookings need to have 

resources deleted and in the Bookings pane click on the Tools Button.  Choose 

“Delete Booking Details Wizard”.   

    

 

 

 

 

 

 

 

 

b. Choose the resource to be deleted and click on Next. 

Personnel 4:00PM resource 
has been removed 
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c. The Select Booking Details window opens.  This window displays all the 

bookings for the selected reservation with a date greater than or equal to the 

current day’s date.  To see old bookings, unclick the Hide Old Bookings at the 

bottom of the window.  CTRL-click to select the bookings that need the resource 

deleted.  Use Select All if all bookings need the resource deleted.  Click on the 

Finish Button. 

 

d. A message will appear that “changes made successfully”.  The resource should 

disappear from the reservation.   

Use CTRL- click to 
select  or click on the 
Select All button 
below 
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21. Changing the Time of a Booking or Multiple Bookings.   

a. In the left pane, select the reservation for which the bookings need to have the 

time changed and in the Bookings pane click on the Tools Button.  Choose 

“Change Booking Date/Time Wizard”.    

 

 

 

 

 

 

 

b. Choose the type of change need to the time.  In this example, we are changing 

the start time to one hour later than the original booking (from 8:00 a.m. to 9:00 

a.m.). 

 

c. Choose hours or minutes in the second drop down list.  For this example we will 

choose hours.  Enter the number of hours or minutes – 1 for this example. 
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d. The Select Booking Details window opens.  This window displays all the 

bookings for the selected reservation with a date greater than or equal to the 

current day’s date.  To see old bookings, unclick the Hide Old Bookings at the 

bottom of the window.  CTRL-click to select the bookings that need the time 

changed.  Use Select All if all bookings need the time changed.  Click on the 

Finish Button, 

 

e. The reservation should now show the time change.  In this example the starting 

time is now 9:00 a.m. instead of the original 8:00 a.m.  Close this screen and it 

will take you back to the changed reservation. 

Use CTRL- click to 
select  or click on the 
Select All button 
below 
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22. Applying a Reservation Discount.   

a. This is not to be used to circumvent the Volusia County Schools Facility Usage 

Fee Schedule.  Use only to discount a room for usage of twenty (20) or more 

hours per week (Sunday through Saturday) or in the event of an irreconcilable 

difference.  For example, the A/C didn’t work during the event.  The system 

automatically has a 10% discount option to choose.   

b. In the left pane, select the reservation to which the discount is being applied.  In 

the Bookings pane, click on the Tools button and choose Apply Reservation 

Discount.   

 

c. In the Reservation Discount field, type in the percentage to be discounted (e.g. 

10%).  Type in a reason for the discount in the Discount Notes field.  Choose the 

category to be discounted (e.g. room charge or food).  CTRL-click to select the 

bookings to be discounted.  Use Select All if all bookings are to be discounted.  

Click on the Finish button. 

Reservation selected 
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d. The discount will appear as a separate line (with an negative amount) on the 

confirmations and invoices. 

e. Another way to apply the discount is to click on the Update Pricing button in the 

upper right pane and choose the 10% off Pricing Plan. Choose the category (e.g. 

room charge) to be discounted and click the Next button. 

 

f. On the Select Bookings window, CTRL-click to select the bookings to be 

discounted.  Use Select All if all bookings are to be discounted.  Click on the 

Finish button. 
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23. Changing the Room Rate for a Reservation.   

a. As we implement this new application, it may become apparent that groups have 

been paying less than what they should for a classroom due to the square 

footage.  Per policy, a classroom with a square footage of up to 1,000 square 

feet is $16 per hour.  A classroom over 1,000 square feet is $24 per hour.  

Portables, regardless of size, are $24 per hour.   

b. If the implementation occurs mid-year or you have already entered into an 

agreement with the group for the $16 per hour, change the room charge and add 

a comment to the reservation that will print on the confirmation and invoice.  This 

comment (Notice of Rate Change) alerts the group that the rate will change 

effective July 1, 2012 and that the size of the room requires a charge of $24 per 

hour in accordance with VCS Facility Usage Fee Schedule.  The comment can 

be changed if needed.   

c. In the Navigator, highlight the reservation and click on the Tools button on the 

lower right panel and choose “Edit Charges”.   
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Highlight the reservation 
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d. The Edit Charges window appears similar to an Excel spreadsheet.  Click on the 

first cell under the Price column and begin changing the rate from $24 to $16.  

This will change the rate for this reservation, but will not affect the rate charged 

for any other reservation (for this group or any other group).  When finished 

making all the rate changes, click on the Recalculate button.  If this looks 

reasonable, click on the Close button.   

 
 

e. To verify that the room charges were changed, drill down to the booking details 

and view the room charge.   

 

 
 

f. Now that the room charge has been changed, the group must be notified that this 

is a temporary change.  A notice of such can be printed on the confirmation and 

the invoice.   

g. In the Navigator, highlight the reservation and click on the Comments tab.  Click 

on the New button.  Next to the Comment Type field, choose “Notice of Rate 

Change” from the drop down list.  A message will appear in the Notes section.  
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This is the message that will print on the confirmation and invoice if you choose 

“Print Comments” on the options tabs.   

 

 

h. Example of the comment on a Confirmation: 

 

i. Example of the comment on an Invoice: 

 
 

Choose “Notice of Rate Change” 

Message that will appear on 
Confirmation or Invoice if you 
choose “Print Comments” on the 
Options tab. 
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24. Navigator Shortcuts. 

a. Highlight the reservation and right mouse click to view shortcut options. 

b. Under “New”, you can add a new booking, reminder, comment, attachment, 

invoice or payment rather than click on the lower right panel or a tab.   

 

c.  Under “Tools”, you can make changes to the bookings, add booking details 

(A/C, lighting, food, personnel), edit charges, or apply a discount.   

 

Highlight the reservation 

Options available 

Highlight the reservation 

Options available 
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d. Other options available are Confirmation, Add Reminders and Comments, or 

Add to Personal Calendar.    
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Chapter 4 
Confirmations 

 

1. In EMS, a confirmation is a document that details the critical information for a 

reservation – the date, times, location, resources, etc.  You send a confirmation to 

the group reserving your school/site’s facility as verification that the reservation has 

been correctly setup.   

2. A confirmation can also be used to inform the group of any outstanding issues 

related to the reservation (such as a balance due) and to provide other information 

that is not necessarily reservation-specific such as your school’s cancellation 

procedures, no smoking rule, etc.   

3. A confirmation can be generated for all bookings in a reservation or just for a 

selected booking.   

4. Confirmation Settings 

a. Confirmation settings can be set one time and used for all confirmations or can 

be changed on as needed basis and tailored for each confirmation. 

b. To specify confirmation settings, open any reservation in the Navigator. 

c. In the upper right hand corner of the Navigator, click Settings > Confirmation 

Settings. 
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d. On the Date Range tab, if needed, change the Name of the school/site 

(Department).  The will be the name that appears at the top of the confirmation.   

 

e. On the Buildings tab, your school/site should already be populated. 

f. On the Categories tab, verify that all categories are in the Selected pane. 
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g. On the Statuses tab, if needed, move Approved, Approved-Private, and Shared 

Space to the Selected pane.   

 

h. On the Options tab, do the following: 

i. In the Confirmation Title field type “Facility Usage Confirmation”.  This will 

appear bold and centered at the top of the confirmation.   

ii. Choose Confirmation Message – Header from the Header Message 

dropdown list.  The following message will appear in the header of the 

confirmation:  “Thank you for selecting our facility to host your upcoming 

event.  Please take a moment to review the details outlined below, and 

contact us with any changes.  The prices listed are estimates and are 

subject to change.”  If changes need to be made to this message, contact 

the Finance Department. 

iii. Choose Confirmation Message – Footer from the Footer Message 

dropdown list. The following message will appear in the footer of the 

confirmation:  “Charges are in accordance with School Board Policy 705.  

Usage is charged by an hourly rate with an hour minimum and 1/2 hour 

increments thereafter.  All users will be charged for any additional services 

provided as a result of the usage.  Additional services may include 

custodial, school nutrition, security, technical support, etc.  Please review 

School Board Policy 705 for details on facilities use.”  If changes need to be 

made to this message, contact the Finance Department.    

iv. If needed, choose the page size from the dropdown list. 



4-4 
 

v. Click on any of the desired options: 

Option Explanation 

Print Comments Include the reservation’s comments in the 

printed confirmation.  Prints below the header.  

Comes from the Reservation comment tab or 

several other comment places. 

Print Reminders Include the reservation’s reminders in the 

printed confirmation.  Prints below header.  

Comes from the Reservation reminder tab or 

several other reminder places. 

Print Cancel Reasons Include reasons for cancellation in the printed 

confirmation 

Print User Defined Fields Include user-defined fields and their values in 

the printed confirmation 

Print Room Phone Include the phone number for the room in 

which the event is being held in the printed 

confirmation 

Print Building Notes Include building notes (directions to the 

school/site) in the printed confirmation.  Prints 

above footer.   

Suppress Reserved Time Hide the reserved time for the booking and 

show only the event time. 

Suppress Location Hide the location for the reservation in the 

printed confirmation 

Suppress Pricing Do not show the reservation’s room charges or 

resource charges in the printed confirmation 
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Suppress Logo Do not show your school’s logo in the printed 

confirmation 

Suppress Item Notes Do not show notes for any booking items in the 

printed confirmation 

Suppress Item Special 

Instructions 

Do not show special instructions for any 

booking items in the printed confirmation 

Limit Bookings to Those 

With Details in Selected 

Categories 

Show only those bookings in the printed 

confirmation that contain details for the 

categories that are selected on the Categories 

tab.   
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i. On the Email Options tab, do the following: 

i. Choose Room Request – Header from the Header Message dropdown list.  

The following message will appear in the body of the emailed confirmation:  

“This email confirms that the following reservation has been approved.” 

ii. Don’t select a Footer Message. 

iii. Choose Mobile Friendly from the Email Format dropdown list. 

iv. Check the Attach Detailed Confirmation box.  The entire confirmation will be 

provided as an attachment to the email. 

v. Check the Attach .ics File box.  An .ics file is a file that a recipient can save to 

create an entry in his/her personal calendar.  

vi. Check the Group box next to Email To.  This will email the confirmation to 

either the VCS employee who reserved the facility or the main contact for the 

group.  In some instances you may want to click on the 1st Contact as well.    
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vii. Once all tabs have been completed or reviewed, click on the Print Preview 

button to view the actual confirmation.   

viii. The confirmation should look similar to this except with your school’s logo (or 

the VCS logo if an administrative site), mailing address and phone number.   

 

 

 

ix. If no changes are needed to the confirmation, use the buttons at the top of the 

screen (just below the toolbar) to print, email and/or export the confirmation.  

1. Click on the Print Button if you would like a copy of the confirmation for your 

files (optional). 

Confirmation Title 

Confirmation Message 

Group 
Information 

Reservation 
Information 

Details for each individual booking 

Building/Room # and Room Description 

No. of hours and room rate 

The price and amount are the # of 
hours multiplied by the room rate 

Qty for rooms will always be 1 
regardless of # hrs 
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2. Click on the Email button to email the confirmation to the Group.  If no 

changes are needed, click on the Send button. 

 

x. To make changes to the confirmation, close the confirmation by clicking on the 

X button in the upper right corner of the screen.  Make the desired changes on 

the appropriate tab and click on the Print Preview button again.   

 

 

Group contact’s email 
address 

Reservation number and 
Group Name Detailed Confirmation 

Attached 

.ics File Attached 

Reservation number and Group Name 

Mobile Friendly Email Format 

Date, times, room, and 
status of each booking 
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Chapter 5 
Dashboard 

 

1. The Dashboard is a window that centralizes critical information about reservations in 

a single location.  The window has nine tabs located vertically on the left pane – 

Notifications, Reminders, Web Reservations, Web Request, Wait List, Reconfirm 

Dates, Building Hours, Exceptions, Analytics and At A Glance.  If any tab on the 

window has at least one record displayed on it, by default, when you log into the 

EMS application, the Dashboard window opens and the Dashboard icon on the main 

toolbar flashes red.  Also, an asterisk (*) appears to the right of the tab name.   

2. The appearance and functions of the Dashboard window can be modified by clicking 

on the word “Options” in the upper right corner of the Dashboard window.   

 

Options Explanation 

Open Dashboard At Startup If 

Items Exist 

Selected by default.  The Dashboard window 

opens automatically after you log into EMS if any 

tab displays at least one item. 

Show Reminders 

Show Web Reservations 

Selected by default.  Indicates the tabs that are to 

be displayed on the Dashboard window. 
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Show Web Requests 

Show Analytics 

Show Wait List 

Show Reconfirm Dates 

Show Building Hours 

Exceptions 

Show At A Glance 

“Thru Today” includes xx Days 

Prior to Today 

Indicates how far into the past that reminders are 

to be displayed in the “Thru Today” view.  The 

default value is seven.   

Activate Flashing Indicator For: 

Notifications 

Reminders 

Web Reservations 

Web Requests 

Set on a per tab basis.  Indicates when the 

Dashboard button on the toolbar is to flash if at 

least one item is displayed on any tab.  Values 

are: 

• Automatically – Immediately when there is at 

least one record that is displayed on the 

indicated tab, even when you are working in 

EMS. 

• At Startup only 

• Never 

Activate Flashing Indicator For: 

Wait List 

Reconfirm Date Reminders 

Building Hours Exceptions 

Set on a per tab basis.  Indicates when the 

Dashboard button on the toolbar is to flash if at 

least one item is displayed on any tab.  Values 

are: 

• At Startup Only 

• Never 

It is recommended that these options are turned 

off since they are not being used at this time. 
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3. Notification Tab 

a. For those in charge of approving facility usage at their school/site, a notification 

rule will be configured to alert you to new reservations/bookings or when 

modifications have occurred existing reservations/bookings. 

b. When the Notifications tab first opens, all the notification rules that include you 

are listed in the Notification Rule pane (upper left pane) of the tab.  Next to the 

words “Notification Rule” is the number of rules that include you.  The number 

next to each rule is the number of new notifications (those with the current day’s 

date).  The following example shows only one notification rule for the user and no 

new notifications for the current date.   

 

One rule that includes 
this user 

No new rules at this 
moment 
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c. The Notifications tab is interactive.  By default, when a rule is selected under 

Notification Rule, all unreviewed notifications appear.  However, by clicking on 

the options under the word “Show” on the mid-right pane, you can view old and 

reviewed notifications.  The example below is a result of clicking on “Old” 

notifications.   

 

d.  Select a notification to view detailed information (such as new booking, changes, 

etc.) in a pane at the bottom of the window.  

  

Notification selected 

Details 
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e. The Notified Users tab will display a list of employees that have been notified of 

this transaction. 

 

f. Select a notification and click on the Go To button to open the item.  If the 

notification is for a reservation/booking, then the reservation opens in the 

Navigator.   

g. Click Refresh to check for notifications that have been issued since you opened 

the Dashboard.   

4. Reminders Tab 

a. A comment is a text entry that explains or clarifies a reservation, booking, group, 

or service order.  A reminder is a comment that has a due date associated with it.  

The Reminder tab displays all the reminders for which you are responsible and 

that have a due date through the current day’s date.   

b. Any reminder created in the Navigator is attached to a specific reservation or 

booking.  Any reminder created in the Groups window is attached to a specific 

group.   

c. Reminders can be created that addresses just your school/site’s operational 

needs and are not attached to any specific item.  These reminders are created 

from the Reminder tab on the Dashboard window as an unattached reminder.   

d. To create an unattached reminder, click on the New button under the Reminders 

tab and under the Reminder Type dropdown list, choose “(user specified 

reminder)”.  Enter a description for the reminder in the Description field.  Your 

user id will appear in the Responsible User field.  This can be changed if you are 

Displays list of those 
notified 
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trying to notify another user.  Enter the due date.  If you are completing the 

reminder today, select a date completed; otherwise, leave this field blank.  This 

field is populated automatically when you or another user completes the 

reminder.   In the Notes field enter any further explanation or information about 

the reminder.  Click OK.  

 

e. Unless the Dashboard options were changed from the default, the reminder will 

appear as a reminder on the Dashboard 7 days prior to the due date.   

f. When the reminder appears on the Dashboard it can be edited, deleted, printed, 

or completed.  To complete the reminder, click on the Completed button.   

 

Dashboard light turns 
red to alert 

Reminder 

“Thru Today” includes 7 
days prior to today (default) 
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g. Once a reminder is completed it will no longer appear on the Dashboard unless 

the Exclude Completed field is unchecked.   

5. Web Reservations Tab 

a. The Web Reservations tab displays any reservation that was submitted through 

VEMS (Virtual EMS).   

b. On the Web Reservation tab, select desired statuses and buildings from the left 

pane if not already populated.  For those in charge of approving facility usage at 

their school/site this may be a duplicate listing of reservations appearing in the 

Notifications tab since you are the responsible individual selected in the 

Notification Rule.     

c. From the list of reservations appearing in the window, begin selecting a 

reservation and clicking on the Go To button to open it in the Navigator.   

6. Web Requests Tab 

a. At this time the District isn’t utilizing Web Requests.  This can be unchecked in 

Options so that it doesn’t appear as a tab. 

7. Wait List Tab 

a. The Wait List tab provides a way of monitoring wait-listed reservations.  It also 

provides an indicator when the requested room becomes available. 

b. Select options (status and building) on the left pane of the tab to filter the 

reservations that are displayed on the tab.  You can also select a different view 

on the View dropdown list. The default value is Thru Today.  To filter the 

reservations based on a specific time range, on the View dropdown list, select 

(user-specified), and then enter at least a starting date in the available date 

fields.  An ending date is optional.  After you select or modify the filtering options, 

click the Refresh button.   

c. Select the reservation in the Reservations list and then click on the Go To button 

to open the reservation in the Navigator.   

8. Reconfirm Dates Tab 

a. At this time the District isn’t utilizing Reconfirm Dates.  This can be unchecked in 

Options so that it doesn’t appear as a tab. 
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9. Building Hours Exceptions Tab 

a. At this time the District isn’t utilizing Building Hours.  This can be unchecked in 

Options so that it doesn’t appear as a tab. 

10. Analytics Tab 

a. The Analytics tab provides quick access for queries that have been defined using 

the Query builder and for which you have been defined as a user.  You can run 

the queries from the Analytics tab.   

b. To run a query from the Analytics tab, click Select Queries in the upper left 

corner.  The Queries dialog box opens.  Select the queries that you want to run 

and click on OK.   

c. The selected queries are displayed in the Queries pane (upper left). 

d. Select the query you wish to run and then select the desired dates and click on 

the Get Data button.   

e. If the query returns data, then the results are displayed in the Results pane.   

f. To export the query results to an Excel spreadsheet or to an XML file, click 

Export, and then select the appropriate file type.  A dialog box opens in which 

you can specify the file name and the location to save the file.   

g. To generate an onscreen preview of the printed query, click Print.  The preview 

window contains options for printing, emailing, etc.   

11. At A Glance Tab 

a. The At A Glance tab provides quick access to high-level booking statistics for 

events at your school/site.  You can select to show booking statistics by 

category, event type, group type, reservations, room type or status.   

b. Be default, when the tab first opens, the date is set to the current day’s date, and 

category is the selected display type.   
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c. To view booking statistics for your school/site on a given date select options 

(status and building) on the left pane and change the date and/or display type as 

needed to view the bookings statistics for a selected date.   
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Chapter 6 
Groups 

 

1. In EMS, a group is an entity for which reservations are made at your facility.  A 

group can be one of the following: 

a. Outside Organization:  Groups not generated by the existence of the school or 

the district, including for-profit users, community groups, governments, and non-

profit users.  

 

b. School-based Organization:  volunteer groups generated by the existence of 

the school, such as booster clubs, parent-teacher organizations, or associations, 

which are providing a service to the school. 

c. VCS Employee – A VCS employee can make a reservation on behalf of a 

school-based organization or for school/district meetings.    Information is loaded 

from the Districts Human Resource software.  Security, however, must be 

obtained from the Finance Department.   

2. A contact is a person who serves as the coordinator for a group.   

3. Groups can only be added by Finance.  Refer to “Responsibilities” in the Introduction 

to EMS chapter.   

4. In EMS, you can view group information such as the address, phone number, email 

address as well as viewing a copy of the hold-harmless agreement and certificate of 

insurance.   

5. To view a group, click on the Groups icon on the toolbar.  To speed up the search, 

you can use the filters at the top of the Groups window (Starts with, Search by, 

Type). 

 

Use these search features to 
quickly find a specific group 
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6. Once a group has been selected, seven tabs appear at the bottom of the screen:  

Contacts, Properties, Reminders, Comments, Attachments, User Defined Fields, 

and Reservations.  The Contacts tab is always the active tab when a group is 

selected.    

  

a. On the Contacts tab, you can view the group’s contact names, phone numbers, 

and email addresses.  Contact Finance if any changes need to be made. 

b. On the Properties tab, you can view the group’s name, mailing address, phone 

number, email address, group type (outside organization, outside org – tax 

exempt, or school-based), etc.   

c. The Reminders tab contains dates for reminders intended for the group.  For 

example, reminding the group to send a new certificate of insurance when the 

one on file expires.    

d. The Comments tab is used to alert schools to something that pertains to the 

group.  For example, if one of schools is experiencing a payment issue with this 

group.   
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e. On the Attachment tab, you can view a copy of the certificate of insurance, 

debarment, and hold-harmless agreement if applicable to that group.  This 

feature allows a group to submit these forms to the Finance Department one 

time only, rather than to each school every time they wish to use their facilities.   

f. The User Defined Fields tab is used for additional tracking information. 

g. On the Reservations tab, you can view all reservations made for the group as 

well as create a new one.   

7. If a group contacts your school to use your facilities and it does not exist in EMS, 

have the group contact the Finance Department.   
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Chapter 7 
Billing 

 
1. In EMS, billing consists of two functions – generating invoices and processing 

received payments.   

2. Invoices can be generated in EMS based on a specific booking date or date range, a 
reservation number, or both.  For example, you can generate invoices for all 
bookings in a month (April 1 through April 30) or for all bookings in reservation 
number 11.   

3. IMPORTANT NOTICE:  Effective January 1, 2020, the Florida Department of 
Revenue reduced the state sales tax rate imposed on the total rent charged for 
renting, leasing, letting, or granting a license to use real property from 6.2% to 6% 
(includes .5% for discretionary sales surtax).  Sales tax is due at the rate in effect 
during the time of the facility usage.   

a. Rental charges paid on or after January 1, 2020 for rental periods prior to 
January 1, 2020 are subject to the sales tax rate of 6.2%.   

b. Rental charges paid on or after January 1, 2020 for rental periods after 
January 1, 2020 are subject to the sales tax rate of 6%.      

c. For this reason, you will need to create separate invoices for facility rental 
prior to 1/1/2020 and then for rentals from 1/1/2020 and beyond.   

For any additional guidance, please refer to Florida Department of Revenue Tax 
Information Publication (TIP) No. 19A01-11 and section 212.031, Florida Statutes.   

4. To generate an invoice for a single reservation, use the Navigator.   

a. Click on the Navigator icon, type in the Reservation No., and click on the OK 
button. 
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b. Highlight the Reservation (top line on the left side pane).  Click on the Update 
Pricing button on the upper right side of the screen.   

 

c. On the Pricing Plan dropdown list at the top, choose “Standard-Prior to 1/1/2020” 
for all reservations dated prior to 1/1/2020.  For reservations dated 1/1/2020 and 
after, choose “Standard”.  Click on Room Charge under Selected Categories, 
and click on the Next button at the bottom. 

 

d. If you chose “Standard-Prior to 1/1/2020”, highlight all reservations that are dated 
prior to 1/1/2020 and click on the Finish button at the bottom.   

Enter reservation 
number 
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e. The following message should appear stating that the pricing update is complete: 

 

f. Click on the Transaction tab, and then click the New button and choose Invoice.  

 

g. The invoicing window opens with several tabs.  The first tab is the Date Range.  
The fields on this tab automatically populate.   
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i. The starting and ending dates are automatically the first and last booking 
dates for the selected reservation.  If you don’t wish to invoice this entire 
time frame, change the date range for which you are generating the invoice.   

ii. The Use Specific Times would only be used if you want to invoice only for 
specific times.  For example, if the booking is from 8 am to 5 pm and you 
want to only invoice for 8am to noon.   

iii. The default for Invoice Date is the current date.  You can leave this date or 
enter a different one.   

iv. The Due Date defaults at 30 days from the current date.  You can leave this 
date or enter a different one.   

 
  

h. On the Buildings tab, all buildings should show under the Selected column.  If 
not, use the arrow button to move them from Available to Selected.   

Do you want this Invoice Date? 

Do you want this Due Date? 
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i. On the Categories tab, all categories should be on the Selected side.  If not, use 
the arrow button to move them from Available to Selected.   

 
 

j.  On the Statuses tab, Approved and Approved – Private should be on the 
Selected side.  Invoices normally would not be generated for reservations in any 
of the other statuses.   

All building should be 
on this side 

If not, use this arrow to 
move to Selected 

All building should be 
on this side 

If not, use this arrow to 
move to Selected 
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k. On the Group Types tab, Outside Org – Tax Exempt and Outside Organization 
should be on the Selected side.  Normally School-Based groups are not invoiced.  
If you need to generate an invoice for that group, however, move it to the 
Selected side.   

 

l. On the Options tab, leave the Header Message blank and in the Footer Message 
field, choose Invoice Message – Footer from the drop down list.  This message 
says “Please make checks payable to the school and mail to the address listed 
above”.   

Approved & Approved 
– Private should be 

here 

All outside 
organizations must be 

on this side 
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i. Click on any of the desired options: 

Option Explanation 

Print Comments Include the reservation’s comments in the 
printed invoice.  Prints below the header.  
Comes from the Reservation comment tab or 
several other comment places. 

Print Reminders Include the reservation’s reminders in the 
printed invoice.  Prints below header.  Comes 
from the Reservation reminder tab or several 
other reminder places. 

Print User Defined Fields Include user-defined fields and their values in 
the printed invoice 

Suppress Reserved Time Hide the reserved time for the booking and 
show only the event time. 

Print Item Notes Include notes for any booking items in the 
printed invoice 

Print Zero Priced Items Include even the zero priced items on the 
printed invoice 
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Print Header On Each Page By default, the header and footer messages 
are printed on every page of the invoice.  To 
print the header only on the first page of the 
invoice, clear this field.   

Suppress Logo Do not show your school’s logo on the 
printed invoice 

m. When finished, click on the Generate button at the bottom.  

 

Prints “Please make checks payable 
to school….” 

To print the header only 
on the first page of the 
invoice, uncheck this 

Check these if comments 
or reminders need to be 
printed on the invoice 
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n. The generated invoices are listed on the Invoicing window.  By default, invoices 
with a zero balance are not shown.  To show zero balances, clear the Hide Zero 
Balances option at the bottom of the window.  To preview an invoice, select the 
invoice (use CTRL- click to select multiple invoices), and click on the Preview 
button.   

 

 
 

o. An onscreen preview of the selected invoice(s) opens.  The preview is titled 
“Invoice Preview” to distinguish previews from invoices that have been posted.  
The previewed invoice will also not have an invoice number, which is issued 
when the invoice is posted.  The preview window contains options such as 
printing a hard copy if desired.  Click on the red X box at the upper right corner to 
close the screen. 

p. If you notice a change is needed to the invoice criteria, click on the Filter button 
to return to the Invoicing window.  After changing the criteria, generate the 
invoice again.   

Select by highlighting 

Click to preview invoice 

Click to make changes to 
the criteria 
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q. To post an invoice, select the invoice (use CTRL-click to select multiple invoices), 
and then click on the Final button.   

r.  

s. A message window opens warning you that you are about to post and print (#) 
invoices, and asking you if you want to continue.  Click on the Yes button. 

t. An onscreen preview of the FINAL invoice opens.  The preview is titled “Invoice” 
and the invoice has been issued an invoice number.  This invoice number 
consists of your school’s organization number in the first 3 digits, followed by the 
next available sequential number, followed by the current fiscal year.   

 

Select by highlighting 

Click to post invoice 

In this case, this invoice is 
for school # 627, the first 
invoice of the year (1), for 
fiscal year 2012 
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u. The preview window contains options for printing a hard copy of the invoice and 
emailing the invoice.  Print the desired number of copies.  The invoice can also 
be emailed as an attachment to the group.  Click on the red X box at the upper 
right corner to close the screen. 

 

 

 

v. After an invoice has been generated, the message “Items have been invoices” is 
displayed in red text on the Reservation Summary tab in the Navigator.  The 
message is also displayed on the Booking Detail Summary tab.  The booking 
detail folder in which the invoiced items reside now has a green background in 
the Items column.   

Click this button to 
email the invoice 

The email address will 
automatically populate this field 

Type in the desired subject an message 
and click on the send button 

Invoice is sent as an attachment 
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w. After an invoice is posted, it is permanently saved.  Any change at this point to 
the balance due can only be made through an adjustment or by voiding the 
invoice and regenerating it.  Because invoiced bookings are locked and cannot 
be edited, you must void the invoice before you can edit the bookings.   

5. To generate an invoice based on a specific booking date or a date range (e.g. 
month), click Billing > Invoices > Invoicing.   
a. The invoicing window opens with several tabs.  Enter the specific book date in 

both the starting and ending date or enter the first and last day of the month to do 
a monthly billing.   The default for Invoice Date is the current date.  You can 
leave this date or enter a different one.  The Due Date defaults at 30 days from 
the current date.  You can leave this date or enter a different one.   

Message appears 

Green = invoiced 
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b. On the Buildings tab, all buildings should show under the Selected column.  If 

not, use the arrow button to move them from Available to Selected.   

 
 

c. On the Categories tab, all categories should be on the Selected side.  If not, 
use the arrow button to move them from Available to Selected.   

Dates for a entire month 

Do you want this Invoice Date? 

Do you want this Due Date? 

All building should be 
on this side 

If not, use this arrow to 
move to Selected 



7-14 
 

 
 

d. On the Statuses tab, Approved and Approved – Private should be on the 
Selected side.  Invoices normally would not be generated for reservations in 
any of the other statuses.   

 

All building should be 
on this side 

If not, use this arrow to 
move to Selected 

Approved & Approved 
– Private should be 

here 
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e. On the Group Types tab, Outside Org – Tax Exempt and Outside 
Organization should be on the Selected side.  Normally School-Based groups 
are not invoiced.  If you need to generate an invoice for that group, however, 
move it to the Selected side.   

  

 

f. On the Options tab, in the Footer Message field, choose Invoice Message 
– Footer from the dropdown list.  This message says “Please make 
checks payable to the school and mail to the address listed above”.   

g. Click on any of the desired options: 

Option Explanation 

Print Comments Include the reservation’s comments in the 
printed invoice.  Prints below the header.  
Comes from the Reservation comment tab 
or several other comment places. 

Print Reminders Include the reservation’s reminders in the 
printed invoice.  Prints below header.  
Comes from the Reservation reminder tab or 
several other reminder places. 

All outside 
organizations must be 

on this side 
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Print User Defined Fields Include user-defined fields and their values 
in the printed invoice 

Suppress Reserved Time Hide the reserved time for the booking and 
show only the event time. 

Print Item Notes Include notes for any booking items in the 
printed invoice 

Print Zero Priced Items Include even the zero priced items on the 
printed invoice 

Print Header On Each Page By default, the header and footer messages 
are printed on every page of the invoice.  To 
print the header only on the first page of the 
invoice, clear this field.   

Suppress Logo Do not show your school’s logo in the 
printed invoice 

h. When finished, click on the Generate button at the bottom.  

 
 

Prints “Please make checks payable 
to school….” 

To print the header only 
on the first page of the 
invoice, uncheck this 

Check these if comments 
or reminders need to be 
printed on the invoice 
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i. The generated invoices are listed on the Invoicing window.  By default, 
invoices with a zero balance are not shown.  To show zero balances, clear 
the Hide Zero Balances option at the bottom of the window.  To preview an 
invoice, select the invoice (use CTRL- click to select multiple invoices), and 
click on the Preview button.   

 
j. An onscreen preview of the selected invoice(s) opens.  The preview is titled 

“Invoice Preview” to distinguish previews from invoices that have been 
posted.  The previewed invoice will also not have an invoice number, which is 
issued when the invoice is posted.  The preview window contains options 
such as printing a hard copy if desired.  Click on the red X box at the upper 
right corner to close the screen. 

k. If you notice a change is needed to the invoice criteria, click on the Filter 
button to return to the Invoicing window.  After changing the criteria, generate 
the invoice again.   

l. To post an invoice, select the invoice (use CTRL-click to select multiple 
invoices), and then click on the Final button.   

Select by highlighting 

Click to preview invoice 

Click to make changes to 
the criteria 
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m. A message window opens warning you that you are about to post and print 

(#) invoices, and asking you if you want to continue.  Click on the Yes button. 
n. An onscreen preview of the FINAL invoice opens.  The preview is titled 

“Invoice” and the invoice has been issued an invoice number.  This invoice 
number consists of your school’s organization number in the first 3 digits, 
followed by the next available sequential number, followed by the current 
fiscal year.   

 
 

o. The preview window contains options for printing a hard copy of the invoice 
and emailing the invoice.  Print the desired number of copies.  The invoice 
can also be emailed as an attachment to the group.  Click on the red X box at 
the upper right corner to close the screen. 

Select by highlighting 

Click to post invoice 

In this case, this invoice is 
for school # 627, the first 
invoice of the year (1), for 
fiscal year 2012 
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p. After an invoices has been generated, the message “Items have been 
invoices” is displayed in red text on the Reservation Summary tab in the 
Navigator.  The message is also displayed on the Booking Detail Summary 
tab.  The booking detail folder in which the invoiced items reside now has a 
green background in the Items column.   

The email address will 
automatically populate this field 

Type in the desired subject an message 
and click on the send button 

Invoice is sent as an attachment 
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q. After an invoice is posted, it is permanently saved.  Any change at this point 

to the balance due can only be made through an adjustment or by voiding the 
invoice and regenerating it.  Because invoiced bookings are locked and 
cannot be edited, you must void the invoice before you can edit the bookings.   

6. To Reprint an Invoice.  Both non-voided and voided invoices can be reprinted.  
Reprinting an invoice does not recalculate the invoice.  It is simply printed as it 
appeared when it was first generated.  You can specify the invoices that are to be 
reprinted or you can search for invoices based on a specific criteria and then select 
specific invoices to reprint from the list of search results.  You can also reprint an 
invoice from the Transaction tab when a reservation is selected in the Navigator.   
a. To specify invoices for reprinting, on the menu bar, click Billing > Other > Reprint 

Invoices.  The Reprint Invoices window opens.  The Department field should 
automatically populate.   
 
 

Message appears 

Green = invoiced 
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Can enter a specific 
invoice number 

Can search by 
transaction dates 

Select sort order for 
reprinted invoices 

Leave this selected to 
include paid invoices  

Select to include any 
associated transactions 

(deposits, payments, etc) 
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b. To reprint an invoice based on transaction dates, enter the dates, select the 
invoice(s) to be reprinted, and move the invoice(s) to the selected side. Click on 
the OK button.  
 

 
c. To reprint a specific invoice, enter the invoice number and click on the Add 

button.  The invoice will automatically appear in the Selected side.  Click on the 
OK button.   

 

Enter the desired 
dates  

Highlight the desired 
invoice(s) 

Use these buttons to 
move all or individual 

invoices to the 
Selected side 

Enter a specific 
invoice number 

Click on this  

Invoice will 
automatically appear 
on the Selected side 
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d. An onscreen preview of the invoice(s) opens.  The preview is titled “Invoice” and 
contains options for printing a hard copy of the invoice and emailing the invoice.  
Print the desired number of copies.  The invoice can also be emailed as an 
attachment to the group.  Click on the red X box at the upper right corner to close 
the screen. 

7. Voiding an Invoice – An invoice can be voided if no payments have been made 
against the invoice.  If a payment has been made against the invoice, you must void 
the payment.  You can specify the invoices that are to be voided or you can search 
for invoices that meet specific criteria, and then select specific invoices to void from 
the list of search results.   
a. To specify invoices to void, click Billings on the menu bar > Other > Void 

Invoices.   
b. The Void Invoices dialog box opens.   

 
c. Enter the criteria to search for the invoice(s) to be voided. 

 

Field Explanation 

Department If not already populated, select the appropriate 
school/site from the Department dropdown list. 

 

Invoice No. If known, enter the invoice number to be voided. 
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First Transaction Date 

Last Transaction Date 

You must enter at least a First transaction date.  
The Last transaction date is optional. 

Show Paid Invoices Leave this option selected to include paid invoices 
in the search.  If you want to void an invoice 
against which payments have been made, then this 
reminder serves to prompt to you to first void the 
payments before you void the invoice.   

  
d. If payments have been applied to the invoice, then an error message opens 

indicating that payments have been applied to the invoice and it cannot be 
voided.  The payments must be voided before you can continue to void the 
invoice.  

e. If payments have not been applied to the invoice, then a Void Reason dialog box 
opens.  Enter a reason for voiding the invoice and click OK. 

 

Enter invoice number to 
void and click the Add 
button 

Enter a reason for 
voiding the invoice 
and click OK 
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f. The invoice is displayed (by number) in the lower right Invoice pane. 

 
g. Optionally, before you void a selected invoice, you can review it to ensure that it 

is indeed the invoice to be voided.  Select the invoice in the lower right Invoice 
pane (CTRL-click to select invoices) and then click Preview. 

h. Select the invoice in the lower right Invoice pane (CTRL-click to select multiple 
invoices), and then click OK. 

i. A message opens asking you if you are sure that you want to void the selected 
invoices.  Click Yes.   

j. A message opens indicating that the invoices have been voided.  Click OK. 
k. The message and Void Invoices dialog box closes.  The Void column is set to 

Yes on the Transaction tab for each of the voided invoices in the Navigator. 
8. Searching for Transactions – A transaction in EMS can be one of four types:  a 

deposit, a payment, an adjustment, or a refund.   
 
Transaction Type Explanation 
Deposit A deposit is the dollar amount paid in advance of an event 

BEFORE invoicing occurs.  A deposit is added to a reservation.  
After you invoice the reservation, all outstanding deposits are 
applied to the invoice to reduce the balance due. A prepayment 
is similar to a deposit and is applied to a reservation. 

 
Payment A payment is the dollar amount that is applied to an invoice to 

reduce the balance due.  A prepayment is similar to a deposit 
and is applied to a reservation. 
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Adjustment An adjustment is a modification that is made to the amount due 

on an existing invoice.  For example, if you send out an invoice 
to a group for $202 and the group sends you a check for $200, 
you can make an adjustment of -$2 to close out the invoice.   

Refund A refund is the return of funds that have been applied to an 
invoiced reservation. 

  
a. To search for a transaction, click Billing on the menu bar > Other > Browse 

Transactions.  The Browse Transaction window appears.  The first time that the 
Browse Transaction window opens, the Filter tab is set to a basic search; 
otherwise the Filter tab is set to the search type that you last carried out (basic or 
advanced).   

 

                                                                                                         
                                           

b. Select the appropriate criteria.   
 
Field Explanation 
Starting & Ending Date The date range during which the 

transactions were carried out.  Both are 
optional. 

Department If not already populated, click on the 
search button and select your 
school/site. 

Transaction Type Leave the default value set to “all” or 
select a specific transaction type. 

Invoice Number If you are searching for a specific 
invoice or invoices, enter a search 
string.  NOTE:  The search is not case-
sensitive, but it is limited to the exact 
order of characters in the string and the 
string must begin with the information 
for which you are searching.  For 
example, if your enter 10 as the search 
string, results can include invoice 

Click to go to the 
Advanced search 

Click to go to the 
Basic search 
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numbers 1000, 1017, etc.   
Reservation ID Leave the default value set to 0 to 

search for a transaction regardless of 
reservation ID; otherwise, enter the 
exact value of the reservation ID. 

Amount Leave the default value set to 0.00 to 
search for transactions regardless of 
the transaction amount; otherwise, 
enter the exact amount of the 
transaction.   

  

 
c. You can change the default value of the number of records returned by clicking 

on Options in the upper right corner.   
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d. After entering criteria, click on the Get Data button.  The search results are 
displayed on the Results tab.   

 
e. You can sort by any field by clicking on the column heading, print, or export the 

results from here.  Click on the Filter button to return to the filter tab to make any 
necessary adjustments to the criteria.   

9. Entering a Deposit – There are two ways to enter a deposit:  (1) Open the 
reservation in the Navigator and on the Transaction tab, click New > Payment; or (2) 
On the menu bar, click Billing > Payments > Payment Entry, and then on the 
Payment Entries window, click New. 
a. The Payment Entry window opens.  Enter the deposit information and click OK. 

 
Field Explanation 

Transaction 
Date 

The default value is the current day’s date.  You can 
modify this value if needed. 

Department If not already populated, select your school/site. 
Transaction 
Type 

Select the transaction type – Deposit (Reservation) or 
Deposit (Bookings) 

• A Deposit (Reservation) is best suited for 
reservations, with one or more bookings, that are 
to be invoiced in their entirety upon completion of 
the event. 

• A Deposit (Bookings) is best suited for reservations 
with multiple bookings, for example, an event with 
multiple occurrences spanning several months, 
that is billed monthly.  A Deposit (Bookings) allows 
you to spread the deposit across multiple months 
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so that only a portion of the deposit is consumed 
and applied to the invoice that is generated 
monthly.  In this scenario, a large deposit that is 
entered as Deposit (Reservation) would be 
consumed in its entirety by the first invoice that is 
generated.  

Payment Type Select the payment type. 
Check No. Enter the check number if you selected “check” as the 

payment type. 
Amount Enter the amount of the payment. 
Reservation No.  Automatically populated if you opened the Payment 

Entry window from the transaction tab in the Navigator; 
otherwise, enter a reservation number or click the 
Search icon to open the Reservations window and 
search for a reservation.  

Invoice No. Not applicable – Deposits are applied before an invoice 
is generated.  The invoicing process totals the charges 
for the specified date range, applies any reservation 
deposits, and results in a net balance due for the 
invoice.   

Notes Optional.  Enter any other comments or statements that 
explain or clarify the payment.  
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10. Entering a Payment - There are two ways to enter a payment:  (1) Open the 
reservation in the Navigator and on the Transaction tab, click New > Payment; or (2) 
On the menu bar, click Billing > Payments > Payment Entry, and then on the 
Payment Entries window, click New. 
a. The Payment Entry window opens.  Enter the payment information and click OK. 

 
Field Explanation 

Transaction Date The default value is the current day’s date.  You can modify 
this value if needed. 

Department If not already populated, select your school/site. 
Transaction Type Select the transaction type – Payment or Pre-payment.  

NOTE:  Pre-payments act just like deposits in that they are 
applied to a reservation and are applied to an invoice 
reducing the balance due.  Payments are applied to an 
invoice.   

Payment Type Select the payment type. 
Check No. Enter the check number if you selected “check” as the 

payment type. 
Amount Enter the amount of the payment. 
Reservation No.  • If you selected Payment as the Transaction Type, then 

this field is not available as payments are applied 
against invoices, not reservations.   

• If you selected Pre-payment as the transaction type, 
then the field is automatically populated if you opened 
the Payment Entry dialog box from the transaction tab 
in the Navigator; otherwise you must enter a 
reservation number or click on the search icon to open 
the reservation window and search for a reservation 

Invoice No. • If you selected Pre-payment as the transaction type, 
then this field is not available as pre-payments are 
applied before an invoice is generated.  

• If you selected Payment as the transaction type, then 
you must enter an invoice number in this field, or click 
the search icon to open the invoices window and 
search for an invoice. 

Notes Optional.  Enter any other comments or statements that 
explain or clarify the payment.  
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11. Entering an Adjustment - There are two ways to enter a deposit:  (1) Open the 

reservation in the Navigator and on the Transaction tab, click New > Payment; or (2) 
On the menu bar, click Billing > Payments > Payment Entry, and then on the 
Payment Entries window, click New. 
a. The Payment Entry window opens.  Enter the payment information and click OK. 

 
Field Explanation 

Transaction Date The default value is the current day’s date.  You can 
modify this value if needed. 

Department If not already populated, select your school/site. 
Transaction Type Select the transaction type – Adjustment 
Payment Type Select the payment type. 
Check No. Enter the check number if you selected “check” as the 

payment type. 
Amount Enter the amount of the adjustment.  To decrease the 

invoice by the indicated amount, enter a minus sign (-) 
before or after the amount. 

Reservation No.  Not applicable – Adjustments are applied to invoices. 
Invoice No. You must enter an invoice number or click the search icon 

to open the invoices window and search for an invoice. 
Notes Optional.  Enter any other comments or statements that 

explain or clarify the payment.  
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12. Entering a Refund - There are two ways to enter a refund:  (1) Open the 
reservation in the Navigator and on the Transaction tab, click New > Payment; or (2) 
On the menu bar, click Billing > Payments > Payment Entry, and then on the 
Payment Entries window, click New. 
a. The Payment Entry window opens.  Enter the refund information and click OK. 

 
Field Explanation 

Transaction Date The default value is the current day’s date.  You can 
modify this value if needed. 

Department If not already populated, select your school/site. 
Transaction Type Select the transaction type – Refund 
Payment Type Select the payment type. 
Check No. Enter the check number if you selected “check” as the 

payment type. 
Amount Enter the amount of the refund.   
Reservation No.  Not applicable – Refunds are applied to invoices. 
Invoice No. You must enter an invoice number or click the search icon 

to open the invoices window and search for an invoice. 
Notes Optional.  Enter any other comments or statements that 

explain or clarify the payment.  
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13. Voiding a Transaction – You can void a transaction for a reservation from the 
Transaction tab or from the Payment Entries window. 

a. To void a transaction from the transaction tab, open the reservation in the 
Navigator.   

i. Open the transaction tab and select the transaction that is to be voided 
(CTRL – click to select multiple transactions) and then click Void. 

ii. A Void Reason window opens.  Enter the reason for voiding the transaction 
and click OK. 

iii. A message appears that the transaction has been voided.  Click OK. 

b. To void a transaction from the Payment Entries window, click Billing on the menu 
bar > Payments > Payment Entry. 

i. The Payment Entries window opens with a list of all transactions that were 
ever made for a selected school/site on a selected date.   

ii. Select the date (the default value is the current day’s date).   

iii. Select eh transaction to be voided and then click Edit.   

iv. The Payment Entry box opens with detailed information for the selected 
transaction.  Click Void and in the Void Comment  field, enter a reason for 
voiding the transaction.  Click OK. 

v. The Payment Entry window reappears.  The Void column is set to Yes for 
the voided transaction.   
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14. Generating a Billing Report – All billing reports are available under the Billing 
option of the menu bar.  For any report, you can specify parameters, options, and 
format for the report, or you can generate the report according to memorized 
settings. 

a. Except for the Billing Worksheet, all billing reports are generated by choosing 
Billing on the menu bar, and then Choosing Reports.   

b. To generate the Billing Worksheet, choose Billing on the menu bar, and then 
Invoices > Billing Worksheet.   

 

c. On the Setup dropdown list, do one of the following: 

i. To generate the report according to the filter settings that you want 
(parameters, options, etc.), leave user-specified selected. 

ii. To run the report with filter settings that have been memorized (saved), 
select the memorized report.  

d. Specify the report parameters, options, and format, print and close the report. 
e. Unless you change the setup, all subsequent reports will be generated and 

printed according to the parameters, options, and format that you have specified.   
If you want to save certain settings so that you do not have to adjust the filter 
settings every time you run the report, you can memorize the report.   
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15. Generating Other Billing Reports – All other billing reports are available on the 
menu bar under Billing > Reports. 

 

a. Aging Report – A list of outstanding invoices.  Current invoices are listed first, 
followed by past due invoices organized by age. Under the Options tab, clicking 
on the Show Unapplied Deposits will display deposits that are applied to 
reservations that have not been invoiced.   

b. Statements – A list of outstanding invoices for a selected group.  Current invoices 
are listed first, followed by past due invoices organized by age.  Under the 
Options tab there are several choices.   

 

Option Explanation 

Report Title Can create a title that is displayed at the top of 
the statement. 

Header Message Select a message from the pre-configured 
messages that is displayed at the top of every 
page of the statement. 

Include Transactions On Zero 
Balance Invoices Within ___ 
Days 

Statements that have a zero balance within the 
specified number of days is displayed 

Show Billing Reference The billing reference number is displayed under 
the invoice information 

Show PO Number The purchase order number is displayed under 
the invoice information 

Show Transaction Notes Any transaction note is displayed. 
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Use Current Group Address The current address of the group in displayed on 
the statement.  This might or might not be the 
address for the group when the reservation was 
made. 

c. Transaction Report – Shows all the billing transactions during a specified period 
if you generate the report in the By Transaction Type by Date format.  Simply 
enter the date or date range and click print.  The report lists the group, event 
name, reservation ID, transaction date, transaction type, invoice number, check 
number, and amount.   

If the report is generated in Standard format, deposits are not shown as 
transactions if they have been absorbed by the generation of an invoice. 

The Transaction Report can also be generated from within a reservation to see 
only transactions for the selected event and you can generate the Transaction 
Report from the print option on the Payment Entries window.  Click Billing > 
Payments > Payment Entry > then on the Payment Entries window, click print.   

d. Voided Transaction Report  - Lists the payments, deposits, or adjustments that 
were voiced on a specific date or within a date range.  Lists the group, event 
name, reservation ID, transaction date and type, invoice number (if applicable), 
check number, and amount. 

e. Invoice Detail Report – Provides detail for all invoices that were generated within 
a given date range. 

f. General Ledger Distribution – Shows the totals for invoices that were generated 
within a given date range.  Entries are broken down by account (facility usage, 
snacks, sales tax, etc), invoice, rate plan, or invoice.  You can also generate this 
report in a Summary format. .  Under the Options tab there are a couple of 
choices.   

 

Option Explanation 

Invoices With Payments Only Only invoices where payment has 
been received are posted on the 
report. 

Show Applied Deposits/Prepayments Applied deposits and prepayments 
are posted on the report.  An applied 
deposit is a deposit on a reservation 
that has been invoiced.   
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The following is an example of a “summary” format: 

 

 

 

The following is an example of a “by invoice” format: 

 

 

40% of this amount must 
be remitted to the District 

Amount to be remitted to 
the Department of 
Revenue 

40% of this amount must 
be remitted to the District 

Amount to be remitted to 
the Department of 
Revenue 
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Chapter 8 
Search Tools 

 

1. EMS has a variety of tools to search for reservations, bookings, service orders, 

resources, and queries.  These include the Browser, Web Reservation, Calendar, 

Navigator, Group, and Web Request. 

2. Using the Browser to search.  

a. On the toolbar, click the Browser Icon.   

 

b. The first time that the Browser window opens, the Filter Tab is set by default to a 

basic search; otherwise the Filter tab is set to the search type you last carried out 

(basic or advanced).   

                        

                                    

c. To carry out a basic search, use the dropdown lists to enter the search criteria.   

Click to go to the 
Basic search 

Click to go to the 
Advanced search 
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i. Select the appropriate criteria.   

 

Field Explanation 

Starting & Ending Date The date range during which the transactions were 
carried out.  Both are optional. 

Use Specific Times Available only if the Starting Date is the same as the 
Ending Date.  

Include Cancelled By default, search results are not set to show 
canceled reservations.  Select this option to search 
for canceled reservations as well. 

Group If the pre-defined list of groups is too extensive to 
scroll, then click the Search icon to open the Groups 
window and search for a specific group.   

1st Contact 

 

Reservation Event Name 

Enter a search string by which to filter your search.  
The search is not case-sensitive, but it is limited to 
the exact order of characters in the string and the 
string must begin with the information for which you 
are searching.  For example, if you enter “ed” as the 
search string, results can include Ed, Edward, Eddie, 
etc. but not Ted or Fred. 

Building If not already populated, this would be your 
school/site 

Room When a building is selected, all rooms in the 
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school/site are selected by default.  You can select a 
specific room in the building.   

Category The default value is set to (all).  You can leave this 
value or select a specific category (booking detail). 

Resource Available only if you select a category that is a 
resource.  The default value is set to (all).  You can 
leave this value or select a specific resource item. 

Booking Status The default values is set to (all).  You can leave this 
value or select a specific booking status. 

  

ii.  You can also click on Options at the upper right corner of the window to 

edit the default values for Date/Time Filter, Number of Records to Return, 

Specific Room Filters and Show Service Order Items. 

iii. Click the Get Data button or Refresh.   
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iv. The search results are displayed on the Results tab. 

 

v. From the Results tab, you can do the following: 

1. To sort the search results, click any column heading. 

2. To rearrange the search results, drag a column to a new location using 

the column heading.   

3. To group results by a specific column, drag the column header as 

indicated on the Results tab. 

4. To open an event in the Navigator, double-click the event entry on the 

Results tab. 

5. Click Print to print the search results. 

6. You can also Email, Export, or download the results to your personal 

calendar in Outlook. 

7. When finished, click the Close button. 
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d. To carry out an advanced search, use the dropdown lists to enter the search 

criteria.   

 

i. Entering a Starting Date and Ending Date is optional. 

ii. If the Starting Date and the Ending Date are the same, select Use Specific 

Times and enter specific time periods to search.  

iii. For each field level option selected, click the Move button (>).  A Filter 

dialog box opens to enter a value or define the limits for the option, and 

then click OK.   
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iv. The option is moved to the Filter Summary panel.   

v. You can also click on Options at the upper right corner of the window to 

edit the default values for Date/Time Filter, Number of Records to Return, 

Specific Room Filters and Show Service Order Items. 

vi. Click the Get Data button or Refresh.   

 

vii. From the Results tab, you can do the following: 

1. To sort the search results, click any column heading. 

2. To rearrange the search results, drag a column to a new location using 

the column heading.   

3. To group results by a specific column, drag the column header as 

indicated on the Results tab. 

4. To open an event in the Navigator, double-click the event entry on the 

Results tab. 

5. Click Print to print the search results. 

6. You can also Email, Export, or download the results to your personal 

calendar in Outlook. 

7. When finished, click the Close button. 
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3. Using the Calendar to search. 

a. On the Toolbar, click on the Calendar icon. 

  

b. By default, the first time the Calendar window opens, the Results tab is the active 

tab and it is set to the current month and year.  If you never modify the Get Data 

when Calendar Opens options (under Options), then the Results tab is always 

the active tab; otherwise, the Filter tab is the active tab.  

 

c. If needed, click on the Filter tab to carry out a basic or advanced search.   
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d. To carry out a basic search use the dropdown lists to enter the search criteria.  

 

i.  Select the appropriate criteria.   

 

Field Explanation 

Month 

Year 

The default value is the current month and year, but 
you can change one or both of these values. 

Include Cancelled By default, search results are not set to show 
canceled reservations.  Select this option to search 
for canceled reservations as well. 

Group If the pre-defined list of groups is too extensive to 
scroll, then click the Search icon to open the Groups 
window and search for a specific group.   

1st Contact 

 

Reservation Event Name 

Enter a search string by which to filter your search.  
The search is not case-sensitive, but it is limited to 
the exact order of characters in the string and the 
string must begin with the information for which you 
are searching.  For example, if you enter “ed” as the 
search string, results can include Ed, Edward, Eddie, 
etc. but not Ted or Fred. 

Building If not already populated, this would be your 
school/site 

Room When a building is selected, all rooms in the 
school/site are selected by default.  You can select a 
specific room in the building.   
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Category The default value is set to (all).  You can leave this 
value or select a specific category (booking detail). 

Resource Available only if you select a category that is a 
resource.  The default value is set to (all).  You can 
leave this value or select a specific resource item. 

Booking Status The default values is set to (all).  You can leave this 
value or select a specific booking status. 

  

ii.  You can also click on Options at the upper right corner of the window to 

edit the default values for Date/Time Filter, Number of Records to Return, 

Specific Room Filters and Show Service Order Items. 

iii. Click the Get Data button or Refresh.   
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iv. The search results are displayed on the Results tab in a calendar view.  

The number of bookings that meet the search criteria is indicted in red on 

the dates on which the events occur.  

  

v. To view a list of bookings for a date, click the date on the calendar.  The 

information appears in the lower pane of the Results tab. 
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vi. From the Results tab, you can do the following: 

1. To sort the search results, click any column heading. 

2. To rearrange the search results, drag a column to a new location using 

the column heading.   

3. To group results by a specific column, drag the column header as 

indicated on the Results tab. 

4. To open an event in the Navigator, double-click the event entry on the 

Results tab. 

5. Click Print to print the search results. 

6. You can also Email, Export, or download the results to your personal 

calendar in Outlook. 

7. When finished, click the Close button. 

e. To carry out an advanced search, use the dropdown lists to enter the search 

criteria.   

 

i. Changing the Month and Year is optional. 
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ii. For each field level option selected, click the Move button (>).  A Filter 

dialog box opens to enter a value or define the limits for the option, and 

then click OK.   

 

iii. The option is moved to the Filter Summary panel.   

iv. You can also click on Options at the upper right corner of the window to 

edit the default values for Date/Time Filter, Number of Records to Return, 

Specific Room Filters and Show Service Order Items. 

v. Click the Get Data button or Refresh.   

 



8-13 
 

vi. From the Results tab, you can do the following: 

1. To sort the search results, click any column heading. 

2. To rearrange the search results, drag a column to a new location using 

the column heading.   

3. To group results by a specific column, drag the column header as 

indicated on the Results tab. 

4. To open an event in the Navigator, double-click the event entry on the 

Results tab. 

5. Click Print to print the search results. 

6. You can also Email, Export, or download the results to your personal 

calendar in Outlook. 

7. When finished, click the Close button. 

4. Searching for Reservations by Group 

a. On the toolbar, click the Groups Icon.   

  

b. The Groups window opens with several options to search from. 

i. In the Starts With field, you can enter the string by which to filter your 

search, and then click Go.  The string is not case-sensitive, but your search 

is limited to the exact order of characters in the string and the string must 

begin with the information for which you are searching.   

ii. In the Search By dropdown list, select the option by which to search.  For 

example, group, contact, or email address.  

iii. In the Type dropdown list, leave the default value of (all) or select the type 

of group or contact by which to filter.  

iv. Click Options to open the Group Options dialog box and then modify any or 

all of the information that is displayed in the dialog box and then click OK to 

close the dialog box and return to the Groups window.   



8-14 
 

 

c. In the Groups window, select a group or contact.  The Groups window is 

refreshed with severak tabs at the bottom of the window.  One of these tabs is a 

Reservations tab.  Open this tab. 

 

d. Double-click on a reservation to open the reservation in the Navigator.   

5. Searching with the Resource Calendar.  

a. Use the Resource Calendar to search for a particular resource and determine 

how much is needed for a specific day or month in a specific year.  For example, 
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how many custodial hours is needed for the month of April.  You can use the 

results to help manage the different categories of resources.   

b. Resources are divided into Categories (ex. A/C and Lighting, Food, Personnel).   

c. On the menu bar, click Reservations > Reservations > Resource Calendar. 

 

 

d. The first time the Resource Calendar opens, the Filter tab is set by default to a 

basic search type; otherwise the Filter tab is set to the search type you last 

carried out (basic or advanced).  

e. Click the Basic/Advanced button to select the type of search to be carried out.  

f. To carry out a basic search, select the appropriate criteria. 

 

Field Explanation 

Month 

Year 

The default value is the current month and year, but you 
can change one or both of these values. 

Include Cancelled By default, search results are not set to show canceled 
reservations.  Select this option to search for canceled 
reservations as well. 

Category Select a specific category (booking detail).  

Resource 

 

Available only if you selected a category that is a resource.  
Select a specific resource item. 

Status The default is set to (all).  You can leave this value as is, or 
you can select a specific booking status.  
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g. You can also click on Options at the upper right corner of the screen and edit the 

default values for one or more additional search options – Date/Time Filter, 

Number of Records to Return, and Specific Room Filters.   

 

h. Click Get Data or Refresh.  The search results are displayed on the Results tab 

in a calendar view.  The total number of resources in all bookings that meet the 

search criteria is indicated in red on the dates on which the events occur.   
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i. To view a list of bookings for a date, click the date on the calendar.  The 

information appears in the lower pane of the Results tab. 

 

ii. From the Results tab, you can do the following: 

1. To sort the search results, click any column heading. 

2. To rearrange the search results, drag a column to a new location using 

the column heading.   

3. To group results by a specific column, drag the column header as 

indicated on the Results tab. 

4. To open an event in the Navigator, double-click the event entry on the 

Results tab. 

5. Click Print to print the search results. 

6. You can also Email, Export, or download the results to your personal 

calendar in Outlook. 

7. When finished, click the Close button. 
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i. To carry out an advanced search, use the dropdown lists to enter the search 

criteria.   

 

i. Changing the Month and Year is optional. 

ii. For each field level option selected, click the Move button (>).  A Filter 

dialog box opens to enter a value or define the limits for the option, and 

then click OK.   
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iii. The option is moved to the Filter Summary panel.   

iv. You can also click on Options at the upper right corner of the window to 

edit the default values for Date/Time Filter, Number of Records to Return, 

Specific Room Filters and Show Service Order Items. 

v. Click the Get Data button or Refresh.   

 

vi. From the Results tab, you can do the following: 

1. To sort the search results, click any column heading. 

2. To rearrange the search results, drag a column to a new location using 

the column heading.   

3. To group results by a specific column, drag the column header as 

indicated on the Results tab. 

4. To open an event in the Navigator, double-click the event entry on the 

Results tab. 

5. Click Print to print the search results. 

6. You can also Email, Export, or download the results to your personal 

calendar in Outlook. 

7. When finished, click the Close button. 
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Chapter 9 
Reports and Queries 

 

1. The EMS application provides six different categories of general reports and a Query 

Builder to assist you in monitoring your school/site’s facility usage.   

2. The reports available are as follows: 

a. Daily 

i. Event Schedule – A summary of the events that are scheduled at your 
school/site, sorted by date and event start time.  The report shows event 
start and end time, group name, event name, and location.   

ii. Event Calendar- A chronological list of scheduled events in a wall calendar 
format.   

iii. Room Cards – A list of events that is designed to be posted outside a room 
or event space.  The report notes the date, event time, and location for 
events, as well as the group sponsoring each event.  The report can be a 
single list of all events that are scheduled for the room on a particular date, 
or it can be a single page per event.  

iv. Activity Schedule – A list of bookings in all rooms in a school, or just in a 
specific room in the school.  The report, which shows event start and end 
times, event name, group name and room, can be generated for a range of 
dates.  The report can be generated in one or two formats – by date or by 
school.   

v. Setup Worksheet – Not applicable since the District does not utilize the 
setup type.  Default is fixed capacity for all rooms.   

vi. Service Order Schedule – Lists the service orders that are scheduled for a 
date or date range.  Produced by category.   

vii. Service Orders – Separate pages for each service order in a date range.  
The report provides information on the event and the items or services 
need.  Produced by category.   

viii. Banquet Event Order – Separate pages for each booking that occurs on a 
date or within a date range that has the “Primary Category” specified.  
Service orders, resource information, notes, and information for resource 
with order type categories are included in this report.   

ix. Resource Schedule – Lists by category and date, how many of each 
resource item is needed, as well as the event time, event name, location, 
and group. 

x. Attendee Visitor Report 

xi. Production Report 
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b. Sales 

i. Sales by Group Type – Lists the sales for each group type for a date or date 
range. 

ii. Sales by Group – Lists the sales for each group, divided by group type, for a 
date or date range.  

iii. Sales by Category – lists the revenue generated by each resource category 
for a date or date range.  

iv. Sales by Resource – Lists the sales of each resource item for a date or date 
range.  

v. Sales by Reservation – Lists the reservations that have bookings for a 
specified date or date range and shows the charges, by category, for the 
reservation.  Also gives a grand total for all reservations.  If a reservation 
also has bookings that fall outside the specified date or date range, these 
figures are not included in the report.  

vi. Sales by Billing Reference – Lists the total sales for a date or date range, 
based on the billing reference number on the reservations that have 
bookings in the specified range.  Sales that are associated with reservations 
that have not billing reference number are not included in the report.   

vii. Sales by Booking – Lists the sales for a particular date or for each date in a 
date range, broken down by booking.  This report displays start/end times, 
group, event name, location, payment type, status, reservation number, 
booking number, and sales amount.   

viii. Status Changes by Reservation – Lists the sales that are associated with a 
reservation where the reservation or booking status was changed.  

ix. Status Changes by Booking – Lists the sales that are associated with 
bookings where the bookings status was changed.   

c. Statistics 

i. Room Statistics – Lists all rooms by school and for each room, indicates the 
number of bookings for the date range selected, the reserved hours, event 
hours, and the estimated attendance.   

ii. Room Utilization – Lists the number of bookings, hours used, hours 
available, percent utilization, and hours vacant for rooms, by school, for the 
date range specified.   

iii. Hourly Room Utilization – Displays room utilization broken down by hours in 
the day, by percentage utilized.  

iv. Hourly Resource Inventory Utilization – Displays resources, and the number 
of items used on an hourly basis for a specified date range.  

v. Group Statistics – Displays number of bookings, reserved hours, event 
hours, and estimated attendance by Group Type for a give date or date 
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range.  The format can be set to “Detail” to provide statistics for each 
specific group.   

vi. Event Type Analysis – Provides information by event type on the number of 
reservations, number of bookings, percentage of total reserved rooms, 
percentage of total event hours, percentage of total estimated attendance, 
and the percentage of total. 

vii. Reservation Source  Analysis – Displays the number of reservations, 
number of bookings with percentage, reserved hours with percentage, event 
hours with percentage, and estimated attendance with percentages by 
reservation source.  

viii. Resource Statistics – Lists the quantity and the hours used, by category and 
by resource item.  

ix. Room Availability - Provides a count of room availability by room type for a 
give date range.  

x. Setup Count Analysis – Lists the total number of bookings by setup count.  

xi. Seat Occupancy Report – Displays the capacity for each room, the number 
of bookings for the date range, the seats available for the bookings, and the 
total estimated attendance.   

xii. Benchmark Metrics Report  

d. Other 

i. Cancellation Report – Lists the bookings that have a status that was 
changed to “Cancelled” on the date or dates specified, or lists the bookings 
on the date or dates specified that have a status type of “Cancelled”.  The 
report also lists the date that the booking status was changed, the date the 
bookings were to have taken place, and the location of the event, the name 
of the person who canceled the booking, the reason for the cancellation, 
and the booking number.  You can run the report in one of two formats – by 
booking date or by cancel date.   

ii. Cancellation Summary – Summarizes, by reservation, all charges for 
bookings on a date or in a date range.  The report shows the first and last 
bookings canceled with the reservation, the group, the reservation number, 
group contact, event name, event type, total charges, and the reason for 
cancellation of the most recently canceled booking.  Reservations that do 
not have charges associated with the bookings are not displayed on this 
report.   

iii. Reservation Summary – A summary of reservations that occurred within a 
specific data range.  The report also lists complete reservation information 
(reservation number, event name, group, contact person, etc.) and booking 
dates.   
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e. Exceptions 

i. Undefined Setups 
ii. Status Reminder Report 
iii. Wait List Report 
iv. Booking Conflict Analysis 
v. Building Hours Exceptions 
vi. Inactive Rooms with Bookings 
vii. Inactive Groups with Reservations 
viii. Invalid Service Orders 
ix. Invalid Billing Reference 
x. Inactive Web Process Template 

f. Queries  

i.  Query Builder 

3. To generate a report, click Reports on the menu bar, choose a category from the 

first list and then the desired report from the second list. Each report will have a 

setup window with various options to specify the report parameters, options, and 

format.  You can print preview, print, email, or export reports. Unless you change the 

filter settings, all subsequent reports are generated and printed according to the 

parameters and options that were set.  You can also “memorize” a report setting for 

future uses.   

4. A memorized report is a report for which the filter settings have been saved, or 

memorized, so that you do not have to adjust the filter settings every time you run a 

report.  You can create a memorized report from scratch or copy an existing one.   

a. To create a memorized report from scratch, click Reports on the menu bar, 

choose a category from the first list and then the desired report from the second 

list.   
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i. All setup windows have the word “Memorize” right above the tabs.  Click this 

to memorize (save) the report settings.   

 

ii. A Memorize Report Setup window will appear.  In the Description field enter 

a name or description (max. of 30 characters) for the report and click OK.  

The box next to Public (Available to All Users) is for administrative user that 

want the report made available to all users.   

 

b. To create a memorized report by copying, click Reports on the menu bar, choose 

a category from the first list and then the desired report from the second list.   
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i. On the setup window choose the memorized report that you wish to copy 

from the dropdown list next to “Setup” (right above the tabs) and then click 

Copy.   

 

ii. A Memorize Report Setup window will appear.  In the Description field enter 

a name or description (max. of 30 characters) for the report and click OK.  

The box next to Public (Available to All Users) is for administrative user that 

want the report made available to all users.   

 

iii. The Report dialog box returns.  The filter settings are populated with the 

settings from the memorized report.  Click on the Edit button and make any 

necessary changes.  Click Memorize.   

iv. A memorized report can also be deleted by clicking on the Delete button on 

the step above.  
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5. A query is the primary mechanism for retrieving information from a database.  A 

query consists of questions that are presented to the database in a predefined 

format.  You can name and save queries that you create.  You can create a query 

from scratch or by copying an existing query and modifying it.  At any time as you 

are going through the tabs to build a query, you can click on the Preview button at 

the bottom of each tab to view the results.   

a. To create a query, click on Reports on the menu bar, choose Queries from the 

first list and then Query Builder from the second list.    

b. The dialog box appears with a list of all queries that have been previously 

defined in your database.  Click on the New button. 

c. The Query Builder Filter tab opens with various options: 

Options Explanation 

Filter Name Name of the query filter.  Can be a maximum of 30 

characters, including spaces) 

Filter Type The type of information that the filter is to capture.   

Display in Browser Available only for a filter type of Billing or Reservations.  

Select this option if the query that you are creating is to 

be available in the Browser.  

Open in Navigator Available only if the Filter Type is Reservations and 

Display in Browser is selected.  Indicate what the system 

should open in the Navigator when a user double-clicks 

on an item that is retrieved by the query.  

Owner Available only to administrative users. 

Return First “xx” 

Number of Records 

To limit the number of records that the query returns, 

select this option, and then enter the number of records 

in the field.  

d. Click on The Display Fields tab and select the fields (CTRL-click to select 

multiple fields) that are to be displayed in the query results, and then click on the 
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move button (>) to move the fields to the right pane.  The Field Search field can 

be used to find fields.  

 

e. Click on the Filter tab and for each field that is to define the query, select the field 

and click on the Move (>) button.  The Field Search field can be used to find 

fields.  As each field is selected, a filter dialog box opens in which you specify the 

criteria for the field (equals, does not equal, greater than, less than, etc.).  Once 

completed, click on the OK button. 
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f. On the sort tab, select the field or CTRL-click to select the multiple fields by 

which the query results are to be sorted and the click the Move (>) button.   

g.  The chart tab is used to graph results of the query.   

h. On the User tab, select users from the Available panel who can run this query 

and move to the Selected panel using the Move (>) button.  By default, all 

administrative users can run any query that any user creates.  These users are 

listed in the Administrators panel.   

i. Once all criteria have been selected and the results are correct,  click OK to save 

the query.   

j. To run a query, click Reports on the menu bar and choose queries from the fist 

list and the actual query you want to run on the second list or click on Query 

Builder and choose the query from the Query Definitions window. 

k. On the Query Results window, choose the booking date/time and click on the Get 

Data button.   

l. Once you have run the query to your satisfaction, you can print the query and/or 

export the results to an Excel spreadsheet, or to an XML file.    
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